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1
Introduction 
and Safety 1

Introduction

Overview The purpose of the ABI PRISM® Cell Lysate Control Kit is to qualify the 
performance of either of the following instruments:

� ABI PRISM™ 6700 Automated Nucleic Acid Workstation

� ABI PRISM™ 6100 Nucleic Acid PrepStation

The qualification process for these instruments in discussed in a 
separate chapter for each instrument.

Safety

Documentation
User Attention

Words

Five user attention words appear in the text of all Applied Biosystems 
user documentation. Each word implies a particular level of observation 
or action as described below.

Note Calls attention to useful information.

IMPORTANT Indicates information that is necessary for proper instrument 
operation.

Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury. It may also be used to alert against 
unsafe practices.

Indicates a potentially hazardous situation which, if not 
avoided, could result in death or serious injury.

Indicates an imminently hazardous situation which, if not 
avoided, will result in death or serious injury. This signal word is to be limited to 
the most extreme situations.

CAUTION!

WARNING!

DANGER!
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Chemical Hazard
Warning

CHEMICAL HAZARD. Some of the chemicals used with 
Applied Biosystems instruments and protocols are potentially hazardous and 
can cause injury, illness, or death.

� Read and understand the material safety data sheets (MSDSs) 
provided by the chemical manufacturer before you store, handle, or 
work with any chemicals or hazardous materials.

� Minimize contact with chemicals. Wear appropriate personal 
protective equipment when handling chemicals (e.g., safety 
glasses, gloves, or protective clothing). For additional safety 
guidelines, consult the MSDS.

� Minimize the inhalation of chemicals. Do not leave chemical 
containers open. Use only with adequate ventilation (e.g., fume 
hood). For additional safety guidelines, consult the MSDS.

� Check regularly for chemical leaks or spills. If a leak or spill occurs, 
follow the manufacturer’s cleanup procedures as recommended on 
the MSDS.

� Comply with all local, state/provincial, or national laws and 
regulations related to chemical storage, handling, and disposal.

Chemical Waste
Hazard Warning

CHEMICAL WASTE HAZARD. Wastes produced by 
Applied Biosystems instruments are potentially hazardous and can cause 
injury, illness, or death.

� Read and understand the material safety data sheets (MSDSs) 
provided by the manufacturers of the chemicals in the waste 
container before you store, handle, or dispose of chemical waste.

� Handle chemical wastes in a fume hood.

� Minimize contact with chemicals. Wear appropriate personal 
protective equipment when handling chemicals (e.g., safety 
glasses, gloves, or protective clothing). For additional safety 
guidelines, consult the MSDS.

� Minimize the inhalation of chemicals. Do not leave chemical 
containers open. Use only with adequate ventilation (e.g., fume 
hood). For additional safety guidelines, consult the MSDS.

� After emptying the waste container, seal it with the cap provided.

� Dispose of the contents of the waste tray and waste bottle in 
accordance with good laboratory practices and local, 
state/provincial, or national environmental and health regulations.

WARNING!

WARNING!
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Site Preparation
and Safety Guide

A site preparation and safety guide is a separate document sent to all 
customers who have purchased an Applied Biosystems instrument. 
Refer to the guide written for your instrument for information on site 
preparation, instrument safety, chemical safety, and waste profiles.

About MSDSs Some of the chemicals used with this instrument may be listed as 
hazardous by their manufacturer. When hazards exist, warnings are 
prominently displayed on the labels of all chemicals.

Chemical manufacturers supply a current material safety data sheet 
(MSDS) before or with shipments of hazardous chemicals to new 
customers and with the first shipment of a hazardous chemical after an 
MSDS update. MSDSs provide you with the safety information you 
need to store, handle, transport and dispose of the chemicals safely.

We strongly recommend that you replace the appropriate MSDS in your 
files each time you receive a new MSDS packaged with a hazardous 
chemical.

CHEMICAL HAZARD. Be sure to familiarize yourself with the 
MSDSs before using reagents or solvents.

WARNING!
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Ordering MSDSs You can order free additional copies of MSDSs for chemicals 
manufactured or distributed by Applied Biosystems using the contact 
information below.

For chemicals not manufactured or distributed by Applied Biosystems, 
call the chemical manufacturer.

To order documents by automated telephone service:

1 From the U.S. or Canada, dial 1.800.487.6809, or from outside the 
U.S. and Canada, dial 1.858.712.0317.

2 Follow the voice instructions to order documents (for delivery by 
fax).

Note There is a limit of five documents per fax request.

To order documents by telephone:

In the U.S. Dial 1.800.345.5224, and press 1.

In Canada

� To order in English, dial 1.800.668.6913 and press 1, 
then 2, then 1

� To order in French, dial 1.800.668.6913 and press 2, 
then 2, then 1

From any other 
country

See the specific region under “To Contact Technical 
Support by Telephone or Fax (Outside North 
America)” on page A-5.

To view, download, or order documents through the Applied Biosystems 
web site:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, click 
Documents on Demand, then click MSDS.

3 Click MSDS Index, search through the list for the chemical of 
interest to you, then click on the MSDS document number for that 
chemical to open a pdf of the MSDS.
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2
6700 Workstation 
Qualification 2

Overview

Purpose of the Cell
Lysate Control Kit

The purpose of the ABI PRISM® Cell Lysate Control Kit is to qualify the 
performance of the ABI PRISM™ 6700 Automated Nucleic Acid 
Workstation. This kit is designed to be used with Applied Biosystems 
reagents and plastic consumables and with the ABI PRISM® 7700 
Sequence Detection System (7700 SDS).

About the Cell
Lysate Control Kit

The Cell Lysate Control Kit contains the following from a single lot of 
human Raji cells:

� Two concentrations of lysed human Raji cells

– High Cell Lysate Control (HCLC)

– Low Cell Lysate Control (LCLC)

� Total RNA recovered from two concentrations of lysed human Raji 
cells and dissolved in Nucleic Acid Purification Elution Solution 
(P/N 4305983)

– High Recovered RNA Standard (HRS)

– Low Recovered RNA Standard (LRS)
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About This
Chapter

This chapter contains the following:

� An overview of the 6700 workstation qualification process

� A list of the equipment and materials required to qualify the 6700 
workstation

� Procedures for setting up the 6700 workstation using the Cell 
Lysate Control Kit, Applied Biosystems reagents, and Applied 
Biosystems plastic consumables on the 6700 workstation

� Procedures for using the 7700 SDS to perform a real-time run and 
to analyze the 6700 workstation output1

� Procedures for analyzing the qualification

1. Verify the performance of the 7700 SDS with the TaqMan® RNase P Instrument 
Verification Plate (P/N 4310982) before analyzing the 6700 workstation output using the 
7700 SDS.
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6700 Workstation Qualification Overview

Process The qualification process involves the following stages:

Stage Overview Process

1 You prepare reagents and gather the materials required to 
perform the 6700 workstation qualification procedure.

2 Using the 6700 system software, you set up the 6700 workstation 
qualification protocols.

3 Using the barcode reader and 6700 system software, you set up 
the Cell Lysate Control Kit reagents, Applied Biosystems 
reagents, and Applied Biosystems plastic consumables on the 
6700 workstation deckspace.

4 The 6700 workstation purifies total RNA from the two 
concentrations of Raji cell lysates (HCLC and LCLC).

5 The 6700 workstation dilutes the RNA from HCLC and LCLC 
samples 1:20 and 1:200.

6 The 6700 workstation prepares two output plates containing 
master mixes, standards, controls, and diluted total RNA samples.

7 You transfer one of the output plates from the 6700 workstation to 
the 7700 SDS for a real-time run.

8 Using the Sequence Detection Systems (SDS) software, you 
analyze the threshold cycles (CT values).

9 You calculate the following to analyze the qualification process:

� % RNA recovery

� Precision of RNA recovery

� % DNA contamination
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Materials and Equipment

Kit Contents The Cell Lysate Control Kit (P/N 4315646) contains sufficient quantities 
to perform one 6700 workstation qualification procedure.

Kit Storage and
Stability

All components of the Cell Lysate Control kit should be stored at 
–15 to –25 °C.

Note If stored correctly, this kit is guaranteed for 1 year from the date of 
manufacture.

Item Descriptiona

a. All components in the packaged kit are produced from a single lot of human Raji cells.

Volume

High Cell Lysate Control 
(HCLC)

Raji cells diluted in lysis bufferb to a 
final concentration of 
5 x 106 cells/mL

b. Lysis buffer consists of a 1:1 mixture of Nucleic Acid Purification Lysis Solution 
(P/N 4305895) and calcium/magnesium-free phosphate-buffered saline solution.

11 mL

Low Cell Lysate Control 
(LCLC)

Raji cells diluted in lysis bufferb to a 
final concentration of 
5 x 104 cells/mL

11 mL

High Recovered RNA 
Standard (HRS)

Total RNA recovered from 1 mL of 
HCLCc, and diluted 1:150

c. The RNA is dissolved in 0.6 mL Nucleic Acid Purification Elution Solution 
(P/N 4305893).

0.6 mL

Low Recovered RNA 
Standard (LRS)

Total RNA recovered from 1 mL of 
LCLCc, and diluted 1:150

0.6 mL
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Equipment and
Materials

Required But Not
Supplied

The following tables list the equipment and materials required in 
addition to the reagents supplied with the Cell Lysate Control Kit.

IMPORTANT Follow the instructions as indicated in this protocol to qualify the 
6700 workstation. If you modify this protocol in any way, including changing the 
amounts used and substituting reagents or other materials, Applied Biosystems 
cannot guarantee the validity of your 6700 workstation qualification process.

Equipment Required

Equipment Source

ABI PRISM 6700 Automated Nucleic Acid 
Workstation

See your Applied 
Biosystems sales 
representativeABI PRISM 7700 Sequence Detection System

Centrifuge with 96-well adapter Major laboratory supplier 
(MLS)

Microcentrifuge MLS

Pipettors MLS

Vortexer MLS

Applied Biosystems Materials Required

Applied Biosystems Materials
Amount 
Needed P/N

6700 Splash Guards 1 guard 4311758

96-Well Optical Reaction Plate with Barcode 8 plates 4306737

Archive Covers 3 covers 4306286

Conductive Pipette Tips, 1000-µL 1 rack 4306377

Conductive Pipette Tips, 200-µL 6 racks 4306375

Microcentrifuge Tubes and Caps, 2-mL 10 tubes 4305936

Nucleic Acid Purification Elution Solution 57.1 mL 4305893

Optical Cover Compression Pad 1 pad 4312639

Optical Heat Seal Covers 2 covers 4307726

Reagent Reservoirs, 120-mL

Note This product comes with a sheet of 
barcode labels for Applied Biosystems nucleic 
acid purification reagents.

4 reservoirs 4304831

Reagent Tubes with Caps, 10-mL 6 tubes 4305932

RNA Purification Wash Solution 1 44 mL 4305891
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RNA Purification Wash Solution 2 117 mL 4305890

TaqMan® One-Step RT-PCR Master Mix 
Reagents Kit

� 2X Master Mix without UNG

Contains AmpliTaq Gold® DNA Polymerase, 
dNTPs with dUTP, Passive Reference, and 
optimized buffer components

� 40X Multiscribe and RNase Inhibitor Mix

3 kits 4309169

TaqMan® Ribosomal RNA Control Reagents 
(VIC™ Dye)

� Human Control RNA

� rRNA Probe (VIC™)

� rRNA Forward Primer

� rRNA Reverse Primer

1 kit 4308329

TaqMan® RNase P Instrument Verification 
Plate

2 plates 4310982

Total RNA Purification Tray 1 tray 4305673

Applied Biosystems Materials Required (continued)

Applied Biosystems Materials
Amount 
Needed P/N
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Reagent Preparation

About Reagent
Preparation

In this section, you prepare the following:

� 18S RT+ master mix

� 18S RT– master mix

� Cell lysate controls

Preparing
1.25X 18S RT+

Master Mix

Prepare 18S RT+ master mix for measuring RNA in samples prepared 
by the 6700 workstation. Use components from the TaqMan One-Step 
RT-PCR Master Mix Reagents Kit and the TaqMan Ribosomal RNA 
Control Reagents (VIC Dye).

To prepare 18S RT+ master mix:

Step Action

1 Pipette the components into a 10-mL reagent tube.

2 Place the 18S RT+ master mix on ice until you load the deckspace.

Component Volume

2X Master Mix without UNG 4.0 mL

rRNA Forward Primer 80 µL

rRNA Reverse Primer 80 µL

rRNA VIC Probe 10 µL

40X Multiscribe and RNase inhibitor mix 200 µL

Deionized water 2.03 mL

Total 6.4 mL
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Preparing
1.25X 18S RT–

Master Mix

Prepare 18S RT– master mix for detecting DNA contamination in 
samples prepared by the 6700 workstation. Use components from the 
TaqMan One-Step RT-PCR Master Mix Reagents Kit and the TaqMan 
Ribosomal RNA Control Reagents (VIC Dye).

Preparing Cell
Lysate Controls

Prepare the cell lysate controls as described below for accurate results.

CHEMICAL HAZARD. Raji cell lysate controls cause 
irritation to the eyes, skin, and respiratory tract. This material is harmful if 
swallowed, inhaled, or absorbed through the skin. It may cause damage to the 
nervous system and bone marrow. Please read the MSDS, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, and 
gloves.

To prepare 18S RT– master mix:

Step Action

1 Pipette the components into a 10-mL reagent tube.

2 Place the 18S RT– master mix on ice until you load the deckspace.

Component Volume

2X Master Mix without UNG 1.5 mL

rRNA Forward Primer 30 µL

rRNA Reverse Primer 30 µL

rRNA VIC Probe 3.75 µL

Deionized water 836 µL

Total 2.4 mL

To prepare cell lysate controls:

Step Action

1 Allow the cell lysate controls to thaw at room temperature or on ice.

IMPORTANT Do not use heat to thaw cell lysate controls.

WARNING!
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2 Vortex cell lysate controls thoroughly to ensure that the controls are 
completely resuspended.

� Use the highest speed setting.

� Place the tubes at an angle while vortexing.

� You should observe liquid from the bottom of the tube mixing 
with liquid at the top of the tube.

IMPORTANT Complete and thorough vortexing is essential for 
accurate results.

3 Pipette the bubbles into a 2-mL microcentrifuge tube, and briefly 
centrifuge the tube to recover liquid.

4 Pipette the recovered liquid from the bubbles back into the correct 
cell lysate tube.

5 Cap and invert the tubes to mix.

6 Place the tubes on ice until you load the tubes on the deckspace.

To prepare cell lysate controls: (continued)

Step Action
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Protocol Setup

Overview In this section you use the 6700 workstation client computer to set up 
the 6700 system software protocols for qualifying the 6700 workstation.

This involves the following procedures:

Logging In

Procedure See Page

Logging In 2-10

Selecting Protocols 2-11

Naming Samples 2-12

Selecting Input Plate Type 2-13

Selecting Samples for the Assay Protocol 2-14

Verifying Protocol Setup 2-15

To log in to the 6700 system:

Step Action

1 Using the 6700 system client computer, go to the Start menu, scroll 
to Programs, and select ABI 6700 Instrument Application to launch 
the 6700 system software.

A 6700 Log-In dialog box appears.

2 Log in.

a. Enter the correct user name and password combination.

b. Click OK.
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Selecting Protocols To select protocols:

Step Action

1 From the Protocol tab, check the box next to protocols required for 
the run.

2 Select the following predefined protocols from the pop-up menu:

Check RNA/DNA Archive

Check Dilution Archive

Check Assay

Protocol Type Predefined Protocol Name

RNA/DNA Archive 6700 RNA Archive

Dilution Archive 1:20/200 Dilution

Assay 6700 Install Assay
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Naming Samples To name samples:

Step Action

1 Right-click the Name button, and choose Select All from the 
contextual menu to select 96 samples.

The software highlights all 96 samples.

Using the mouse, 
right-click this 
button to view the 
contextual menu

This contextual 
menu appears 
after you right-click 
the Name button
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Selecting Input
Plate Type

2 Right-click the Name button, and select AutoFill Sample Names from 
the contextual menu.

A dialog box appears.

3 Click OK.

The software names the samples using the formula in the Sample 
Name field.

To name samples: (continued)

Step Action

To select input plate type:

Step Action

1 Select Lysed from the Input Plate Type pop-up menu.
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Selecting Samples
for the Assay

Protocol

To select samples for the Assay protocol:

Step Action

1 Select wells 1–48 for the Assay protocol in the Select Samples for 
Assay Protocol section.

Note Click and drag, or hold down the Ctrl key while selecting 
samples.

The software highlights the corresponding Well column in the 
Archive Sample Names section of the Protocol tab.

2 Verify that the screen looks like the figure shown below.

Select samples 1–48 for 
the Assay protocol
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Verifying Protocol
Setup

To verify protocol setup:

Step Action

1 Click the Deckspace tab.

The software determines whether the protocols are set up properly.

2
If the protocols… Then…

are set up properly, the Deckspace tab becomes active.

are not set up 
properly,

a Protocol Verification Errors dialog 
box appears.

Click the Print button to print the 
errors, and click Close to close the 
box.

Resolve the errors before proceeding.
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Deckspace Setup

Purpose In this section, you use the 6700 system software and the barcode 
reader to set up the Cell Lysate Control Kit reagents, Applied 
Biosystems reagents, and Applied Biosystems plastic consumables on 
the 6700 workstation deckspace.

Deckspace setup involves the following procedures:

Procedure See Page

Cooling the Deckspace 2-17

Selecting Plate Cover Options 2-17

Loading Plates 2-19

Loading Tips 2-21

Loading Reagents 2-21

Loading Master Mixes 2-23

Loading Standards 2-24

Loading the Covers 2-25

Loading the Splash Guard 2-26

Verifying the Deckspace 2-28
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Cooling the
Deckspace

Begin cooling the deckspace Peltier units before setting up the 
deckspace to prevent degradation of your input, standards, controls, 
and master mixes.

Selecting Plate
Cover Options

To cool the deckspace:

Step Action

1 Go to the Instrument tab.

2 Click the Cool Peltiers button.

The 6700 instrument begins to cool the following stations to 4 °C:

� Input Station

� Standards, Master Mix/Cell Lysate Control Station

� Dilutions/cDNA Station

� Output Station

Note It takes up to 20 minutes to cool the stations to 4 °C.

To select plate cover options:

Step Action

1 Click the Deckspace tab.

2 Check Use Covers for Archive and Dilution Archive Plates for the 
robotic arm to automatically place archive covers on the Archive 
plates and Dilution archive plates after the run.

Three of the Cover stations turn yellow.

3 Check Seal Output Plates to seal the Output plates with optical heat 
seal covers for the heat sealer to automatically place optical heat 
seal covers on output plates at the end of the run.

The Heat Seals location turns yellow.
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Consumables and
Reagents Required

Gather the consumables and reagents required before setting up the 
deckspace.

Consumables and Reagents Amount Needed

18S RT+ Master Mix 6.4 mL

18S RT– Master Mix 2.4 mL

6700 Splash Guard 1 guard

96-Well Optical Reaction Plate with Barcode 5 plates

96-Well Optical Reaction Plate with Barcode 
(placeholders)a

a. Placeholders are required to minimize condensation fomation on Peltier-cooled 
deckspace stations.

3 plates

Archive Covers 3 covers

Conductive Pipette Tips, 1000-µL 1 rack

Conductive Pipette Tips, 200-µL 6 racks

High Cell Lysate Control 11 mL

High Recovered RNA Standard 0.6 mL

Low Cell Lysate Control 11 mL

Low Recovered RNA Standard 0.6 mL

Microcentrifuge Tubes and Caps, 2-mL 1 tube

Microcentrifuge Tubes and Caps, 2-mL 
(placeholders)a

9 tubes

Nucleic Acid Purification Elution Solution 57.1 mL

Reagent Reservoirs, 120-mL 4 reservoirs

Reagent Tubes with Caps, 10-mL (placeholders)a 4 tubes

RNA Purification Wash Solution 1 44 mL

RNA Purification Wash Solution 2 63 mL + 54 mL

Total RNA Purification Tray 1 tray
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Loading the
Deckspace

Follow the guidelines below when loading the deckspace:

� Load the deckspace using the barcode reader and the Deckspace 
tab.

� Enter unique barcodes or Consumable IDs for archive plates and 
output plates.

� Load placeholder items to minimize condensation formation on 
Peltier-cooled deckspace stations.

� To reset the deckspace, click the Reset Deckspace button.

Loading Plates To load plates:

Step Action

1 Using the barcode reader, scan a plate location on the deckspace.

LASER HAZARD. Exposure to direct or reflected 
laser light can burn the retina and leave permanent blind spots. 
Never look into the laser beam. Remove jewelry and anything else 
that can reflect the beam into your eyes. Protect others from 
exposure to the beam.

� Details about the deckspace location appear to the left of the 
deckspace diagram.

� The software checks the On Deckspace check box, and the 
Consumable ID box becomes active.

2 Scan the barcode of the plate.

Note You need to perform this step only if the plate is not a 
placeholder plate.

WARNING!
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3 Place the plate on the deckspace.

4 Repeat step 1 through step 3 until you place all required plates on 
the deckspace.

IMPORTANT Loading placeholder plates is required to minimize 
condensation formation on Peltier-cooled deckspace stations.

To load plates: (continued)

Step Action

Deckspace 
Location Plate Required

Input 1 Placeholder 96-well plate

Archive 96-well barcoded microplate

Purification Total RNA purification tray

Dilution 1 96-well barcoded microplate

Dilution 2 96-well barcoded microplate

Output 1 96-well barcoded microplate

Output 2 96-well barcoded microplate

Output 3 Placeholder 96-well plate

Output 4 Placeholder 96-well plate
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Loading Tips

Loading Reagents

To load tips:

Step Action

1 Using the barcode reader, scan a tip location on the deckspace.

LASER HAZARD. Exposure to direct or reflected 
laser light can burn the retina and leave permanent blind spots. 
Never look into the laser beam. Remove jewelry and anything else 
that can reflect the beam into your eyes. Protect others from 
exposure to the beam.

� Details about the deckspace location appear to the left of the 
deckspace diagram.

� The software checks the On Deckspace check box, and the 
Consumable ID box becomes active.

2 Scan the barcode of the tip rack (optional).

3 Place the tip rack on the deckspace.

4 Repeat step 1 through step 3 until you place all required tips on the 
deckspace.

WARNING!

Load 1000-µL disposable 
tips in tip position 5

Load 200-µL disposable 
tips in tip positions 6 and 7

Load 200-µL disposable 
tips in tip positions 1–4

To load reagents:

Step Action

1 Place 44 mL of RNA Purification Wash Solution 1 in a reagent 
reservoir, and place a Wash Solution 1 barcode label on the 
reagent reservoir.

CHEMICAL HAZARD. RNA Purification Wash 
Solution 1 may cause eye, skin, and respiratory tract irritation. 
Please read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Note Barcode labels for the reagent reservoirs are packaged with 
the reagent reservoirs.

CAUTION!
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2 Place 54 mL of RNA Purification Wash Solution 2 in a reagent 
reservoir, and place a Wash Solution 2 barcode label on the 
reagent reservoir.

CHEMICAL HAZARD. RNA Purification Wash 
Solution 2 is a flammable liquid and vapor. Please read the MSDS, 
and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

3 Place 63 mL of RNA Purification Wash Solution 2 in a reagent 
reservoir, and place a Wash Solution 2 barcode label on the 
reagent reservoir.

CHEMICAL HAZARD. RNA Purification Wash 
Solution 2 is a flammable liquid and vapor. Please read the MSDS, 
and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

4 Place 57 mL of Nucleic Acid Purification Elution Solution in a 
reagent reservoir, and place an Elution Solution barcode label on 
the reagent reservoir.

5 Using the barcode reader, scan a reagent reservoir location on the 
deckspace.

LASER HAZARD. Exposure to direct or reflected 
laser light can burn the retina and leave permanent blind spots. 
Never look into the laser beam. Remove jewelry and anything else 
that can reflect the beam into your eyes. Protect others from 
exposure to the beam.

� Details about the deckspace location appear to the left of the 
deckspace diagram.

� The software checks the On Deckspace check box, and the 
Consumable ID box becomes active.

6 Scan the barcode of the reagent reservoir.

To load reagents: (continued)

Step Action

WARNING!

WARNING!

WARNING!
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Loading Master
Mixes

7 Place the reagent reservoir on the deckspace.

CHEMICAL HAZARD. RNA Purification Wash 
Solution 1 may cause eye, skin, and respiratory tract irritation. 
Please read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

CHEMICAL HAZARD. RNA Purification Wash 
Solution 2 is a flammable liquid and vapor. Please read the MSDS, 
and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

8 Repeat step 5 through step 7 until you place all required reagents 
on the deckspace.

To load reagents: (continued)

Step Action

Load 57 mL of Nucleic Acid Purification Elution 
Solution in reagent position 8

Load 44 mL of RNA Purification Wash Solution 1 
in reagent position 1

Load 54 mL of RNA Purification Wash Solution 2 
in reagent position 2

Load 63 mL of RNA Purification Wash Solution 2 
in reagent position 3

CAUTION!

WARNING!

To load master mixes:

Step Action

1 Using the barcode reader, scan a master mix location on the 
deckspace.

LASER HAZARD. Exposure to direct or reflected 
laser light can burn the retina and leave permanent blind spots. 
Never look into the laser beam. Remove jewelry and anything else 
that can reflect the beam into your eyes. Protect others from 
exposure to the beam.

� Details about the deckspace location appear to the left of the 
deckspace diagram.

� The software checks the On Deckspace check box, and the 
Consumable ID box becomes active.

WARNING!
6700 Workstation Qualification 2-23



Loading Standards

2 Place the appropriate master mix on the deckspace.

CHEMICAL HAZARD. Raji cell lysate controls 
cause irritation to the eyes, skin, and respiratory tract. This material 
is harmful if swallowed, inhaled, or absorbed through the skin. It 
may cause damage to the nervous system and bone marrow. 
Please read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

3 Repeat step 1 and step 2 until you scan all master mix barcodes 
and place all required master mix tubes on the deckspace.

To load master mixes:

Step Action

Load 6.4 mL of 18S RT+ Master Mix

Load 2.4 mL of 18S RT– Master Mix

Load 4 empty 10-mL reagent tubes

Load High Cell Lysate Control tube

Load Low Cell Lysate Control tube

WARNING!

To load standards:

Step Action

1 Using the barcode reader, scan the standards location on the 
deckspace.

Standard position 1 becomes active.

LASER HAZARD. Exposure to direct or reflected 
laser light can burn the retina and leave permanent blind spots. 
Never look into the laser beam. Remove jewelry and anything else 
that can reflect the beam into your eyes. Protect others from 
exposure to the beam.

WARNING!
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Loading the
Covers

2 Load the standards, control, and placeholder tubes on the 
deckspace.

3 Mark the standards, control, and placeholder tubes as On 
Deckspace.

a. Using the mouse, click a standard position on the Deckspace 
tab.

b. Using the mouse, click the On Deckspace check box.

Repeat steps 3a and 3b until all standards and controls are marked 
as On Deckspace.

To load standards: (continued)

Step Action

Load the Low Recovered RNA 
Standard in position 2
Load 100 µL of Nucleic Acid 
Purification Elution Solution in 
position 12 as the No Template 
Control

Load empty 2-mL microcentrifuge 
tubes in positions 3–11

Load the High Recovered RNA 
Standard in position 1

To load the covers:

Step Action

1 Using the barcode reader, scan the optical heat seal covers 
barcode on the deckspace.

LASER HAZARD. Exposure to direct or reflected 
laser light can burn the retina and leave permanent blind spots. 
Never look into the laser beam. Remove jewelry and anything else 
that can reflect the beam into your eyes. Protect others from 
exposure to the beam.

WARNING!
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Loading the Splash
Guard

2 Place no more than four optical heat seal covers in position.

IMPORTANT Place the optical heat seal covers with the dull side 
facing downward and the shiny side facing upward.

3 Using the barcode reader, scan a Cover barcode on the archive 
cover shelf.

4 Place an archive cover on the archive cover shelf.

5 Repeat step 3 and step 4 until you place all archive covers.

To load the covers: (continued)

Step Action

Place the 
optical 
heat seal 
covers in 
the 
sealing 
station

To load the splash guard:

Step Action

1 Using the barcode reader, scan the waste position barcode on the 
deckspace.

LASER HAZARD. Exposure to direct or reflected 
laser light can burn the retina and leave permanent blind spots. 
Never look into the laser beam. Remove jewelry and anything else 
that can reflect the beam into your eyes. Protect others from 
exposure to the beam.

WARNING!
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\

2 Load the splash guard in the waste position.

IMPORTANT The splash guard is a blue plate with bottomless 
wells. Do not load a 96-well plate in the waste position. If you do, 
waste will collect on the deckspace.

To load the splash guard: (continued)

Step Action

Load the 
splash 
guard in 
the waste 
position
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Verifying the
Deckspace

To verify the deckspace:

Step Action

1 Verify that all active stations on the Deckspace tab are green.

Note This indicates that all required materials were marked as On 
Deckspace.

2 Verify that all required items are placed in the appropriate 
deckspace position.

3 Verify that the volumes for reagents, master mixes, standards, and 
controls are correct.

IMPORTANT Missing items or insufficient amounts may cause the 
instrument to pause during the qualification run. This will require 
manual intervention to restart and complete the qualification run.
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6700 Instrument Run

Purpose In this section you start the 6700 instrument run, and the 6700 
workstation purifies the RNA, dilutes the RNA, and prepares output 
plates.

This involves the following procedures:

Starting the Run

Procedure See Page

Starting the Run 2-29

Finishing the Run 2-30

To start the run:

Step Action

1 Close the instrument door.

2 Go to the Instrument tab of the software.

3 Click the Start button.

The software verifies that all locations are marked as On 
Deckspace. If you did not mark all locations as On Deckspace, an 
error message will appear, asking you to return to the Deckspace 
tab.

4 Make sure the instrument door is completely closed before 
proceeding.

5 Click OK.
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Finishing the Run

6 Enter a name for the run in the Name Run dialog box that appears.

Note The run name must contain fewer than 23 characters.

If you have not already clicked the Cool Peltiers button, the Peltiers 
begin to cool.

7 Click OK.

8 View the Run Log pane to monitor the process.

To start the run: (continued)

Step Action

To finish the run:

Step Action

1 Verify that the run is completed by checking the status section of 
the Instrument tab.

2 Open the door of the 6700 instrument.

3 Clear the deckspace.

a. Remove the archive plates and output plates from the 
deckspace.

b. Store the archive plates and output plates until needed.

4 Click the Turn Peltiers Off button.

IMPORTANT If you leave the Peltiers on, water will collect on the 
deckspace and flood it. If this occurs, the temperature sensors may 
malfunction and fail to report deckspace temperatures accurately.

Plate Deckspace Location

Recommended 
Storage 

Temperature

RNA archive Vacuum station –15 to –25 °C

Dilution archive 
plates

Dilution/cDNA Archive 
station

–15 to –25 °C

Output plates Output station 2 to 8 °C
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Output Plate Setup
Files Description

After the run, the 6700 database exports information about each output 
plate in an output plate setup file.

File Attribute Output Plate Setup File Information

Location 6700_client\D:\pebio\6700\Output Plate Setup Files

Name

If you…
Then the file is named 
with the…

scanned Consumable 
IDs

Consumable ID.

did not scan 
Consumable IDs

 year-month-day and the 
output plate number.
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Real-Time PCR Run

Purpose In this section, you select one Assay output plate from the 6700 
workstation qualification run for a real-time run on the ABI PRISM 7700 
Sequence Detection System (7700 SDS).

IMPORTANT Verify the performance of the 7700 SDS with the TaqMan® 

RNase P Instrument Verification Plate (P/N 4310982) before analyzing the 6700 
workstation output using the 7700 SDS.

A real-time run involves the following procedures:

Setting Up
Real-Time Run

Files

Set up a real-time run file with sample types, reporters, dyes, and 
sample location. You can do this two ways:

� Importing sample type setup files created by the 6700 system 
software

� Setting up the run file manually using 7700 SDS software

Use the table below to determine which procedure to follow.

Procedure See Page

Setting Up Real-Time Run Files 2-32

Programming Thermal Cycler Conditions 2-37

Loading the Reaction Plate 2-38

If the 6700 database server is…
Then set up the real-time run files 
by following the procedure in…

networked “Importing Setup Files” on 
page 2-33.

not networked and the 7700 SDS 
computer has a floppy drive

“Importing Setup Files” on 
page 2-33.

not networked and the 7700 SDS 
computer does not have a floppy 
drive

“Performing Sample Type Setup” on 
page 2-34.
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Importing Setup
Files

Import setup files created by the 6700 workstation client computer if you 
can transfer the output plate setup files via the network or floppy disks.

To import setup files:

Step Action

1 Locate the output plate setup files on the 6700 workstation client 
computer hard drive.

a. Go to D:\pebio\6700\Output Plate Setup Files on the client 
computer.

b. Find the appropriate output plate setup file.

Note The setup file is named with the Consumable ID or with the 
year, month, day and output plate number.

2 Transfer the file to the 7700 SDS computer.

3 Launch SDS software on the computer connected to the 7700 SDS.

Close the untitled window that appears.

4 From the File menu, select New Plate...

A New Plate dialog box appears.

If the 6700 database server 
is… Then…

networked transfer the file using the 
network.

not networked and the 7700 
SDS computer has a floppy 
drive

transfer the file using a floppy 
disk.

not networked and the 7700 
SDS computer does not have 
a floppy drive

go to the next section, 
“Performing Sample Type 
Setup,” and follow the 
procedures for manually 
setting up the run file.
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Performing
Sample Type

Setup

5 Complete the New Plate dialog box as shown below:

6 Click OK.

An untitled window appears in the setup view.

7 Go to the File menu, scroll to Import, and select Import Setup File.

8 Locate the output plate setup file, and click Open.

The SDS software imports plate setup information.

9 Go to “Programming Thermal Cycler Conditions” on page 2-37.

To import setup files: (continued)

Step Action

To perform sample type setup:

Step Action

1 Launch SDS software on the computer connected to the 7700 SDS.

Close the untitled window that appears.

2 From the File menu, select New Plate...

A New Plate dialog box appears.

3 Complete the New Plate dialog box as shown below:
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4 Click OK.

An untitled window appears in the setup view.

5 From the Sample Type pop-up menu, select Sample Type Setup...

The Sample Type Setup dialog box appears.

6 Complete the Sample Type Setup dialog box.

a. Set the following sample types with the reporter dye VIC:

� NTC

� UNKN

� STND

b. Verify that ROX is shown as the Reference dye.

c. Verify that TAMRA is selected as the Quencher dye.

d. Click OK.

The dialog box closes and the untitled window becomes active.

To perform sample type setup: (continued)

Step Action

Select VIC as the 
Reporter for Sample 
Types

Select TAMRA as the 
Quencher

The Reference should 
be ROX
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7 Select VIC from the Dye Layer pop-up menu.

8 Label STND-Standard wells.

a. Select wells A1–A12 and B1–B8.

b. From the Sample Type pop-up menu, select STND-Standard.

9 Label NTC-No Template Control wells.

a. Select wells B9, B10, F11, and F12.

Note Hold down the Control key to select multiple wells.

b. From the Sample Type pop-up menu, select NTC-No Template 
Control.

10 Label UNKN-Unknown wells.

a. Select wells B11, B12, C1–C12, D1–D12, E1–E12, F1–F10, 
G1–G12, and H1–H12.

b. From the Sample Type pop-up menu, select UNKN-Unknown.

The samples are set up as shown in the figure below.

11 Save the changes to the run file.

To perform sample type setup: (continued)

Step Action
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Programming
Thermal Cycler

Conditions

12 Go to “Programming Thermal Cycler Conditions” on page 2-37.

To perform sample type setup: (continued)

Step Action

To program thermal cycler conditions:

Step Action

1 Program thermal cycling settings.

a. Click the Thermal Cycler Conditions button.

A Thermal Cycler Conditions dialog box appears.

b. Program the Thermal Cycler Conditions as shown below.

c. Set the Reaction Volume to 50 µL.
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Loading the
Reaction Plate

2 Program data collection settings.

a. Click the Show Data Collection button in the dialog box.

Document icons indicate when the instrument will collect data.

b. Set the document icons as shown in the figure below.

Note Click a line segment to add or remove document icons.

3 Click OK.

The dialog box closes, and the plate read window becomes active.

To program thermal cycler conditions: (continued)

Step Action

To load the reaction plate:

Step Action

1 Place an optical cover compression pad on top of one of the two 
output plates from the 6700 workstation run.

2 Load the output plate into the 7700 SDS sample block.

IMPORTANT Start the 7700 SDS run immediately to prevent 
degradation of the reaction components.
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3 Secure the heated cover over the output plate.

a. Pull the heated cover forward.

b. Turn the knob clockwise to lower and secure the heated cover 
over the output plate

When securing the heated cover in place, be 
careful not to overtighten the knob. Damage to the instrument could 
occur.

4 Start the 7700 SDS run.

a. Click the Show Analysis button.

The analysis view appears.

b. Make sure that the temperature of the heated cover (Cov Temp) 
is > 100 °C.

c. Click the Run button.

d. Wait for the instrument to beep and the shutters to click before 
leaving.

To load the reaction plate: (continued)

Step Action

CAUTION!
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Amplification Plot Analysis

Purpose In this section, you use Sequence Detection Systems (SDS) 
software v. 1.6 or later to analyze the amplification plot and export the 
data.

This involves the following procedures:

Setting Analysis
Options

Procedure See Page

Setting Analysis Options 2-40

Analyzing Threshold Cycles 2-42

Exporting Data 2-45

To set analysis options:

Step Action

1 Save the real-time run file.

2 Click the Show Analysis button.

The analysis view appears.

3 From the Analysis menu, select Options.

An Analysis Options dialog box appears.
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Baseline and
Threshold
Guidelines

In analyzing threshold cycles (see the next page), you set the baseline 
and threshold values for analysis. Follow the guidelines below to ensure 
accurate analysis of the data.

Setting the Baseline

� Set the baseline to start at a cycle when background fluorescence 
is detected by the 7700 SDS.

Baselines usually start between 2 and 3.

� Set the baseline to stop at a cycle before fluorescence signals from 
amplification are generated and detected.

Baselines usually stop between 6 and 8.

Setting the Threshold

� Set the threshold value to 0.05.

At this value, fluorescence signals generated from RT+ samples 
should be increasing logarithmically. Adjustment of the threshold 
value from 0.05 may be necessary for optimal results.

4 Set the Analysis Options dialog box as shown below.

5 Click OK.

To set analysis options: (continued)

Step Action
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Analyzing
Threshold Cycles

To analyze threshold cycles:

Step Action

1 Select all wells.

2 From the Analysis menu, select Analyze.

The software analyzes the data, and an Amplification Plot window 
appears.

3 Set the Threshold Cycle Calculation values.

a. Set the Threshold value to 0.05.

b. Set the Baseline to Start at 2–3.

c. Set the Baseline to Stop at 6–8.
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4 Click Update Calculations.

The software updates the Amplification Plot.

5 Verify that the baseline and threshold are set properly.

a. The cycles set for the baseline should show no amplification.

b. The threshold value should indicate logarithmic growth of ∆Rn 
values.

To analyze threshold cycles: (continued)

Step Action

The threshold 
value indicates a 
logarithmic 
increase in ∆Rn 
values for all 
samples

There is no 
amplification in 
baseline cycles
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6 From the Viewer pop-up menu, select Ct vs Well position.

The view of the amplification plot changes.

7 Save the file.

To analyze threshold cycles: (continued)

Step Action

RT+ samples RT– samples

HRS

LRS NTC NTC

HCLC
LCLC

HCLC
LCLC
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Exporting Data To export data:

Step Action

1 From the File menu, scroll to Export, and select Results.

A file dialog box appears.

2 Enter the file name for the exported data, select a location for the 
data file, and click Export.

The data are exported into a data file in the selected location.
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Threshold Cycle Analysis

Purpose In this section you manipulate the exported data using Microsoft® Excel 
to calculate CT averages and standard deviations for the different 
sample groups. See “Example Qualification Data and Calculations” on 
page 2-57 for an example of a qualification analysis.

Threshold cycle analysis involves the following procedures:

Preparing the
Data File

Procedure See Page

Preparing the Data File 2-46

Calculating Average CT Values and Standard Deviations 2-49

Eliminating Outliers From Analysis 2-52

Eliminating Dropouts From Analysis 2-52

To prepare the data file:

Step Action

1 Using Microsoft Excel, open the data.xls file you saved in “Exporting 
Data” on page 2-45.

A Text Import Wizard dialog box appears.
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2 Complete Step 1 of the Text Import Wizard dialog box.

a. Select Delimited as the Original data type.

b. Start at row 1.

c. Select the appropriate File Origin.

d. Click Next.

3 Complete Step 2 of the Text Import Wizard dialog box.

a. Check the Tab box.

b. Click Next.

To prepare the data file: (continued)

Step Action
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4 Complete Step 3 of the Text Import Wizard dialog box.

a. Select General as the Column data format.

b. Click Finish.

The data file opens as a spreadsheet.

5 Delete the following columns:

� Baseline StdDev

� deltaRn

� Quantity

� Replicate

� Qty Mean

� Qty StdDev

� IPC

� Sample Name

6 Insert five columns:

� Avg CT (2x)

� Avg CT (2x) sorted

� Avg CT

� STDEV

� Specs

To prepare the data file: (continued)

Step Action
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Calculating
Average CT Values

and Standard
Deviations

7 Add cell borders to distinguish between the sample types.

a. Select row 11.

b. Click the Borders button.

The software applies a border to the bottom of row 11.

c. Repeat steps 7a and 7b for the following rows.

To prepare the data file: (continued)

Step Action

21 59 85

23 71 91

34 73 97

47 79

To calculate average CT values:

Step Action

1 Calculate the average CT value for each set of duplicates (HCLC 
RT+ and LCLC RT+ samples) in the Avg CT (2x) column.

a. In cell E24, enter the formula =AVERAGE(D24:D25), and press 
Return.

The software calculates the average for samples 23 and 24, a 
set of duplicates.

b. Select cells E24 and E25, and from the Edit menu, select Copy.

c. Select cells E26 through E71, and from the Edit menu, select 
Paste.

The software calculates the average for the remaining sets of 
duplicates.

2 Paste the average CT values for HCLC RT+ samples into column F.

a. Hold down the Command key, and select the average CT values 
in column E for HCLC RT+ samples.

b. From the Edit menu, select Copy.

c. Place the cursor in cell F24.

d. From the Edit menu, select Paste.
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3 Paste the average CT values for LCLC RT+ samples into column F.

a. Hold down the Command key, and select the average CT values 
in column E for LCLC RT+ samples.

b. From the Edit menu, select Copy.

c. Place the cursor in cell F36.

d. From the Edit menu, select Paste.

4 Sort the CT values for the sets of duplicates for the HCLC RT+ and 
for the LCLC RT+ samples in the Avg CT (2x) sorted column.

a. Select samples F24:F35, and from the Data menu select Sort.

b. Select samples F36:F47, and from the Data menu select Sort.

5 Calculate the average CT value for each sample group in the Avg CT 
column.

To calculate average CT values: (continued)

Step Action

In cell… Enter the formula…
Sample 
Group

G2 =AVERAGE(D2:D11) HRS RT+

G12 =AVERAGE(D12:D21) LRS RT+

G22 =AVERAGE(D22:D23) NTC RT+

G24 =AVERAGE(D24:D35, D48:D59) HCLC RT+

G36 =AVERAGE(D36:D47, D60:D71) LCLC RT+

G72 =AVERAGE(D72:D73) NTC RT–

G74 =AVERAGE(D74:D79, D86:D91) HCLC RT–

G80 =AVERAGE(D80:D85, D92:D97) LCLC RT–
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6 Calculate the standard deviation for CT values for each sample 
group in the STDEV column (column I).

7 Eliminate samples following the guidelines in the following sections, 
“Eliminating Outliers From Analysis” and “Eliminating Dropouts 
From Analysis,” before proceeding with the specification 
calculations.

To calculate average CT values: (continued)

Step Action

In cell… Enter the formula…
Sample 
Group

H2 =STDEV(D2:D11) HRS RT+

H12 =STDEV(D12:D21) LRS RT+

H22 =STDEV(D22:D23) NTC RT+

H24 =STDEV(F24:F29) HCLC RT+ 
below avg

H25 =STDEV(F30:F35) HCLC RT+ 
above avg

H36 =STDEV(F36:F41) LCLC RT+ 
below avg

H37 =STDEV(F42:F47) LCLC RT+ 
above avg

H72 =STDEV(D72:D73) NTC RT–

H74 =STDEV(D74:D79, D86:D91) HCLC RT–

H80 =STDEV(D80:D85, D92:D97) LCLC RT–
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Eliminating
Outliers From

Analysis

An outlier exhibits a CT value that differs by greater than three standard 
deviations from the average CT value for the sample group.

Eliminate from analysis up to four outliers from each output plate:

� Eliminate an RT+ sample from analysis if the CT value of the RT+ 
sample differs by greater than three standard deviations from the 
average CT value for the sample group and the CT value of the 
sample’s replicate is within three standard deviations of the average 
CT value for the sample group.

Note If the CT values of a sample and its replicate both differ by greater than 
three standard deviations of the average CT value for the sample group, then 
the sample set meets the definition of a dropout (See the next section, 
“Eliminating Dropouts From Analysis.”).

� Eliminate an RT– sample from analysis if the CT value of the RT–  
sample differs by greater than three standard deviations from the 
average CT value for the sample group.

� Eliminate a standard from analysis if the CT value of the standard 
differs by greater than three standard deviations from the average 
CT value for the sample group

Eliminating
Dropouts From

Analysis

A dropout consists of a set of duplicate samples that both exhibit CT 
values that differ by greater than three standard deviations from the 
average CT value for the sample group.

Eliminate up to two dropouts from each output plate from analysis.
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Qualification Analysis

Purpose In this section you use the CT values to measure the quality of the RNA 
prepared by the 6700 workstation using three performance parameters.

Calculating
% RNA Recovery

For the RNA recovery to meet or exceed 50% of the RNA content of the 
lysate, the following equations must be true.

CT(HCLC RT+) – CT(HRS RT+) < 1.0

CT(LCLC RT+) – CT(LRS RT+) < 1.0

Performance Specification

% RNA Recovery The 6700 workstation can recover ≥50% of 
the RNA content of the cell lysate control.

Precision of RNA Recovery The 6700 workstation can recover RNA with 
a precision of <30% coefficient of variation 
(CV).

% DNA Contamination The 6700 workstation can recover RNA 
containing <0.5% of DNA by weight.

To calculate % RNA recovery:

Step Action

1 Calculate ∆CT values for HCLC RT+ samples compared to standard 
HRS RT+ samples.

a. In cell I2, enter the formula =G24 – G2.

b. Verify that the difference is less than 1.0.

2 Calculate ∆CT values for LCLC RT+ samples compared to standard 
LRS RT+ samples.

a. In cell I12, enter the formula =G36 – G12.

b. Verify that the difference is less than 1.0.
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Calculating
Precision of RNA

Recovery

For the precision of RNA recovery to be less than 30% CV, the following 
equations must be true for the HCLC RT+ population and for the LCLC 
RT+ population.

For the standard deviation of CT values below the average CT:

[10(Std. Dev. CT/3.33) – 1] x 100 < 30%

For the standard deviation of CT values above the average CT:

[10(–Std. Dev. CT/3.33) – 1] x 100 < 30%

To calculate precision of RNA recovery:

Step Action

1 Calculate the % CV for the standard deviation of HCLC RT+ CT 
values below the average.

a. In cell I24, enter the formula

b. Press Return to calculate.

The % CV should be less than 30% for the installation to pass 
performance verification.

2 Calculate the % CV for the standard deviation of HCLC RT+ CT 
values above the average.

a. In cell K25, enter the formula

b. Press Return to calculate.

The % CV should be less than 30% for the installation to pass 
performance verification.

=(POWER(10, A/ 3.33)–1)*100

Where A is the value from cell H24, the standard 
deviation for HCLC RT+ CT values below the average

=(POWER(10, – B/ 3.33)–1)*100

Where B is the value from cell H25, the standard 
deviation for HCLC RT+ CT values above the 
average
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Calculating
% DNA

Contamination

For DNA contamination in the RNA samples to be less than 0.5% by 
weight, the following equation must be true:

CT(HCLC RT–) – CT(HCLC RT+) ≥ 16

3 Calculate the % CV for the standard deviation of LCLC RT+ CT 
values below the average.

a. In cell I36, enter the formula

b. Press Return to calculate.

The % CV should be less than 30% for the installation to pass 
performance verification.

4 Calculate the % CV for the standard deviation of LCLC RT+ CT 
values above the average.

a. In cell K37 for LCLC RT+ samples, enter the formula

b. Press Return to calculate.

The % CV should be less than 30% for the installation to pass 
performance verification.

To calculate precision of RNA recovery: (continued)

Step Action

=(POWER(10, C/ 3.33)–1)*100

Where C is the value from cell H36, the standard 
deviation for LCLC RT+ CT values below the average

=(POWER(10, – D/ 3.33)–1)*100

Where D is the value from cell H37, the standard 
deviation for LCLC RT+ CT values above the average

To calculate % DNA contamination:

Step Action

1 In cell I74, enter the formula =G74–G24.

2 Press Return to calculate.

3 Verify that the value is greater than or equal to 16.
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6700 Qualification
Requirement

Qualification of the 6700 instrument using the Cell Lysate Control kit 
requires that the purified RNA meets Applied Biosystems specifications 
for % RNA recovery, precision of RNA recovery, and % DNA 
contamination.

If one or more of the specifications is not met, please do one of the 
following:

� Contact technical support (see “Technical Support” on page A-1) 
for assistance with using the kit or analyzing the data.

� Contact your Applied Biosystems service representative for service 
of your 6700 workstation.
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Example Qualification Data and Calculations

Purpose This appendix contains data and calculations from an example 6700 
workstation qualification run.

Example % RNA
Recovery

The figure below shows example data and calculations for determining 
% RNA recovery.

Example Precision
of RNA Recovery

The next figure shows example data and calculations for determining 
precision of RNA recovery.

∆CT values 
for HCLC 
RT+ 
samples 
compared to 
HRS RT+ 
samples is 
less than 1.0

∆CT values 
for LCLC 
RT+ 
samples 
compared to 
LRS RT+ 
samples is 
less than 1.0
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Example % DNA
Contamination

The figure below shows example data and calculations for determining 
% DNA contamination.

Table of Formulas The table below describes the formula or contents for each cell.

Cell Formula/Contents

E24 =AVERAGE(D24:D25)

E26:E71 pasted from E24:E25

F24:F35 pasted from E24:E34, E48:E58 and 
sorted in ascending order

F36:F47 pasted from E36:E46, E60:E70 and 
sorted in ascending order

G2 =AVERAGE(D2:D11)

G12 =AVERAGE(D12:D21)

G22 =AVERAGE(D22:D23)
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G24 =AVERAGE(D24:D35, D48:D59)

G36 =AVERAGE(D36:D47, D60:D71)

G72 =AVERAGE(D72:D73)

G74 =AVERAGE(D74:D79, D86:D91)

G80 =AVERAGE(D80:D85, D92:D97)

H2 =STDEV(D2:D11)

H12 =STDEV(D12:D21)

H22 =STDEV(D22:D23)

H24 =STDEV(F24:F29)

H25 =STDEV(F30:F35)

H36 =STDEV(F36:F41)

H37 =STDEV(F42:F47)

H72 =STDEV(D72:D73)

H74 =STDEV(D74:D79, D86:D91)

H80 =STDEV(D80:D85, D92:D97)

I2 =G24–G2

I12 =G36–G12

I24 =(POWER(10,A/3.33)–1)*100

Note A is the value from cell H24.

I25 =(POWER(10,–B/3.33)–1)*100

Note B is the value from cell H25.

I36 =(POWER(10,C/3.33)–1)*100

Note C is the value from cell H36.

I37 =(POWER(10,–D/3.33)–1)*100

Note D is the value from cell H37.

I74 =G74–G24

Cell Formula/Contents
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3
6100 PrepStation 
Qualification 3

Overview

Purpose of the Cell
Lysate Control Kit

The purpose of the ABI PRISM® Cell Lysate Control Kit is to qualify the 
performance of the ABI PRISM™ 6100 Nucleic Acid PrepStation. This kit 
is designed to be used with Applied Biosystems reagents and plastic 
consumables and with either the ABI PRISM® 7700 Sequence Detection 
System (7700 SDS) or a spectrophotometer.

About the Cell
Lysate Control Kit

The Cell Lysate Control Kit contains the following from a single lot of 
human Raji cells:

� Two concentrations of lysed human Raji cells

– High Cell Lysate Control (HCLC)

– Low Cell Lysate Control (LCLC)

� Total RNA recovered from two concentrations of lysed human Raji 
cells and dissolved in Nucleic Acid Purification Elution Solution 
(P/N 4305983)

– High Recovered RNA Standard (HRS)

– Low Recovered RNA Standard (LRS)
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About This
Chapter

This chapter contains the following:

� An overview of the 6100 prepstation qualification process

� A list of the equipment and materials required to qualify the 6100 
prepstation

� Procedures for using the 6100 prepstation with the Cell Lysate 
Control Kit, Applied Biosystems reagents, and Applied Biosystems 
plastic consumables

� If using a spectrophotometer for analysis:

– Procedures for verifying the purity of the total RNA by 
measuring the absorbance at 260 nm and 280 nm for the total 
RNA from the High Cell Lysate Control

� If using the 7700 SDS for PCR and analysis:

– Procedures for using the 7700 SDS to perform a real-time run 
and to analyze the 6100 prepstation output1

– Procedures for analyzing the qualification

1. Verify the performance of the 7700 SDS with the TaqMan® RNase P Instrument 
Verification Plate (P/N 4310982) before analyzing the 6100 prepstation output using the 
7700 SDS.
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6100 Instrument Qualification Overview

Process The qualification process involves the following stages:

Prepare reagents and gather materials.

Use 6100 prepstation to purify total RNA.

Analysis Using Spectrophotometer

Pipette any HCLC sample from
6100 prepstation run on to the

spectrophotometer.

Using the spectrophotometer,
measure the absorbance at

260 nm and 280 nm.

Calculate the 260/280 ratio.

Analysis Using 7700 SDS

Dilute RNA from HCLC and
LCLC samples obtained on

6100 prepstation run.

Load a 96-well plate for the
7700 SDS.

Perform real-time PCR run on
the 7700 SDS.

Analyze amplification plot of
7700 SDS.

Analyze threshold cycle using
Microsoft Excel.

Analyze the qualification data
using Microsoft Excel.
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Materials and Equipment

Kit Contents The Cell Lysate Control Kit (P/N 4315646) contains sufficient quantities 
to perform one 6100 prepstation qualification procedure.

Kit Storage and
Stability

All components of the Cell Lysate Control kit should be stored at 
–15 to –25 °C.

Note If stored correctly, this kit is guaranteed for 1 year from the date of 
manufacture.

Item Descriptiona

a. All components in the packaged kit are produced from a single lot of human Raji cells.

Volume

High Cell Lysate Control 
(HCLC)

Raji cells diluted in lysis bufferb to a 
final concentration of 
5 x 106 cells/mL

b. Lysis buffer consists of a 1:1 mixture of Nucleic Acid Purification Lysis Solution 
(P/N 4305895) and calcium/magnesium-free phosphate-buffered saline solution.

11 mL

Low Cell Lysate Control 
(LCLC)

Raji cells diluted in lysis bufferb to a 
final concentration of 
5 x 104 cells/mL

11 mL

High Recovered RNA 
Standard (HRS)

Total RNA recovered from 1 mL of 
HCLCc, and diluted 1:150

c. The RNA is dissolved in 0.6 mL Nucleic Acid Purification Elution Solution 
(P/N 4305893).

0.6 mL

Low Recovered RNA 
Standard (LRS)

Total RNA recovered from 1 mL of 
LCLCc, and diluted 1:150

0.6 mL
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Equipment and
Materials

Required But Not
Supplied

The following tables list the equipment and materials required in 
addition to the reagents supplied with the Cell Lysate Control Kit.

IMPORTANT Follow the instructions as indicated in this protocol to qualify the 
6100 prepstation. If you modify this protocol in any way, including changing the 
amounts used and substituting reagents or other materials, Applied Biosystems 
cannot guarantee the validity of your 6100 prepstation qualification process.

Equipment Required

Equipment Source

ABI PRISM 6100 Nucleic Acid PrepStation See your Applied 
Biosystems sales 
representative

ABI PRISM 7700 Sequence Detection System
or
Spectrophotometer

Centrifuge with 96-well adapter Major laboratory supplier 
(MLS)

Microcentrifuge MLS

Pipettors MLS

Vortexer MLS

Applied Biosystems Materials Required

Applied Biosystems Materials
Amount 
Needed P/N

For 6100 prepstation

Microcentrifuge Tubes and Caps, 2-mL 10 tubes 4305936

6100 Splash Guard 1 guard 4311758

96-Well Optical Reaction Plate with Barcode 1 plate 4306737

Total RNA Purification Tray 1 tray 4305673

RNA Purification Wash Solution 1 44 mL 4305891

RNA Purification Wash Solution 2 117 mL 4305890

Nucleic Acid Purification Elution Solution 57.1 mL 4305893
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For 7700 SDS

Reagent Tubes with Caps, 10-mL 6 tubes 4305932

96-Well Optical Reaction Plate with Barcode 3 plates 4306737

Optical Adhesive Cover 1 cover 4311971

Optical Cover Compression Pad 1 pad 4312639

TaqMan® One-Step RT-PCR Master Mix 
Reagents Kit

� 2X Master Mix without UNG

Contains AmpliTaq Gold® DNA Polymerase, 
dNTPs with dUTP, Passive Reference, and 
optimized buffer components

� 40X Multiscribe and RNase Inhibitor Mix

3 kits 4309169

TaqMan® Ribosomal RNA Control Reagents 
(VIC™ Dye)

� Human Control RNA

� rRNA Probe (VIC™)

� rRNA Forward Primer

� rRNA Reverse Primer

1 kit 4308329

TaqMan® RNase P Instrument Verification 
Plate

2 plates 4310982

Applied Biosystems Materials Required (continued)

Applied Biosystems Materials
Amount 
Needed P/N
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Reagent Preparation

About Reagent
Preparation

In this section, you prepare the following:

� Cell lysate controls

� 18S RT+ master mix (for 7700 SDS only)

� 18S RT– master mix (for 7700 SDS only)

Preparing Cell
Lysate Controls

Prepare the cell lysate controls as described below for accurate results.

CHEMICAL HAZARD. Raji cell lysate controls cause 
irritation to the eyes, skin, and respiratory tract. This material is harmful if 
swallowed, inhaled, or absorbed through the skin. It may cause damage to the 
nervous system and bone marrow. Please read the MSDS, and follow the 
handling instructions. Wear appropriate protective eyewear, clothing, and 
gloves.

To prepare cell lysate controls:

Step Action

1 Allow the cell lysate controls to thaw at room temperature or on ice.

IMPORTANT Do not use heat to thaw cell lysate controls.

2 Vortex cell lysate controls thoroughly to ensure that the controls are 
completely resuspended.

� Use the highest speed setting.

� Place the tubes at an angle while vortexing.

� You should observe liquid from the bottom of the tube mixing 
with liquid at the top of the tube.

IMPORTANT Complete and thorough vortexing is essential for 
accurate results.

3 Pipette the bubbles into a 2-mL microcentrifuge tube, and briefly 
centrifuge the tube to recover liquid.

4 Pipette the recovered liquid from the bubbles back into the correct 
cell lysate tube.

5 Cap and invert the tubes to mix.

6 Place the tubes on ice until you load the purification tray.

WARNING!
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Preparing
1.25X 18S RT+

Master Mix

If using the 7700 SDS for analysis, perform the following procedure. 
Prepare 18S RT+ master mix for measuring RNA in samples prepared 
by the 6100 prepstation. Use components from the TaqMan One-Step 
RT-PCR Master Mix Reagents Kit and the TaqMan Ribosomal RNA 
Control Reagents (VIC Dye).

To prepare 18S RT+ master mix:

Step Action

1 Pipette the components into a 10-mL reagent tube.

2 Place the 18S RT+ master mix on ice until you load the 96-well 
plate for the 7700 SDS.

Component Volume

2X Master Mix without UNG 4.0 mL

rRNA Forward Primer 80 µL

rRNA Reverse Primer 80 µL

rRNA VIC Probe 10 µL

40X Multiscribe and RNase inhibitor mix 200 µL

Deionized water 2.03 mL

Total 6.4 mL
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Preparing
1.25X 18S RT–

Master Mix

If using the 7700 SDS for analysis, perform the following procedure. 
Prepare 18S RT– master mix for detecting DNA contamination in 
samples prepared by the 6100 prepstation. Use components from the 
TaqMan One-Step RT-PCR Master Mix Reagents Kit and the TaqMan 
Ribosomal RNA Control Reagents (VIC Dye).

To prepare 18S RT– master mix:

Step Action

1 Pipette the components into a 10-mL reagent tube.

2 Place the 18S RT– master mix on ice until you load the 96-well 
plate for the 7700 SDS.

Component Volume

2X Master Mix without UNG 1.5 mL

rRNA Forward Primer 30 µL

rRNA Reverse Primer 30 µL

rRNA VIC Probe 3.75 µL

Deionized water 836 µL

Total 2.4 mL
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6100 PrepStation Run

Overview Performing the 6100 prepstation run consists of the following 
procedures, which must be done in order:

Accessing
Predefined Method

Procedure See Page

Accessing Predefined Method 3-10

Loading Disposables 3-11

Loading Purification Tray 3-12

Running the RNA Cell Method 3-13

To access the RNA Cell predefined method: 

Step Action

1 From the main menu, press F3 (User).

The Select User Name screen appears.

2 Use the arrow keys to highlight user ABI.

3 Press F1 (Select).

The main menu appears showing ABI as the user name.

Select User Name

F1 F3 F4 F5F2

Select CancelDeleteEditNew

andy
markr
markh

markb
peterh

<ABI>
<ALL>

MM:DD:YY

F1 F3 F4 F5F2

Quick UtilLogUserMethod

Applied Biosystems

Version 00.01

User: ABI

HH:MM:SS
ABI PRISM™ 6100 PrepStation
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Loading
Disposables

4 Press F2 (Method).

The Method Select 1 screen appears.

5 Use the up and down arrow keys to highlight the RNA Cell method.

6 Press F1 (Run).

The Method View screen appears.

To access the RNA Cell predefined method: (continued)

Step Action

Method
Pre-Filter

User
ABI

F1 F3 F4 F5F2

Run DoneMoreEditNew

Steps
7

LastUsed
01/17/01

RNA Blood
RNA Cell
RNA Tissue-Filtr

ABI
ABI
ABI

3
9
9

01/16/01
01/15/01
01/04/01�

�

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
120

Position
Waste1

120
120

20%

20%
2
3 Waste

Waste 20%
�

To load disposables on the 6100 prepstation: 

Step Action

1 Place a 96-well archive plate on top of the adapter in the collection 
compartment.

2 Place a splash guard in the waste compartment.

3 Place a total RNA purification tray in the carriage. Turn the two 
knobs to secure the tray in place.

4 Move the carriage to the waste position. Push the carriage handle 
down until the carriage locks into position (seals).
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Loading
Purification Tray

To load the purification tray: 

Step Action

1 Pre-wet the purification tray by pipetting 40 µL of RNA purification 
wash solution 1 over each well of the purification tray.

CHEMICAL HAZARD. RNA purification wash 
solution 1 may cause eye, skin, and respiratory tract irritation. 
Please read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

2 Pipette 200 µL of High Cell Lysate Control (HCLC) or Low Cell 
Lysate Control (LCLC) into each well according to the plate map 
shown page 3-13.

CHEMICAL HAZARD. Raji cell lysate controls 
cause irritation to the eyes, skin, and respiratory tract. This material 
is harmful if swallowed, inhaled, or absorbed through the skin. It 
may cause damage to the nervous system and bone marrow. 
Please read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

3 Ensure that the highlighter is at step 1 of the RNA Cell method, 
then press F1 (Start).

CAUTION!

WARNING!

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
120

Position
Waste1

120
120

20%

20%
2
3 Waste

Waste 20%
�
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Plate Map for 6100 prepstation

Running the RNA
Cell Method

1 2 3 4 5 6 7 8 9 10 11 12

A HCLC HCLC HCLC HCLC HCLC HCLC LCLC LCLC LCLC LCLC LCLC LCLC

B HCLC HCLC HCLC HCLC HCLC HCLC LCLC LCLC LCLC LCLC LCLC LCLC

C HCLC HCLC HCLC HCLC HCLC HCLC LCLC LCLC LCLC LCLC LCLC LCLC

D HCLC HCLC HCLC HCLC HCLC HCLC LCLC LCLC LCLC LCLC LCLC LCLC

E HCLC HCLC HCLC HCLC HCLC HCLC LCLC LCLC LCLC LCLC LCLC LCLC

F HCLC HCLC HCLC HCLC HCLC HCLC LCLC LCLC LCLC LCLC LCLC LCLC

G HCLC HCLC HCLC HCLC HCLC HCLC LCLC LCLC LCLC LCLC LCLC LCLC

H HCLC HCLC HCLC HCLC HCLC HCLC LCLC LCLC LCLC LCLC LCLC LCLC

To run the rest of the RNA Cell method: 

Step Action

1 Perform the first wash.

a. Pipette 500 µL of RNA purification wash solution 1 over each 
sample in the purification tray.

CHEMICAL HAZARD. RNA purification wash 
solution 1 may cause eye, skin, and respiratory tract irritation. 
Please read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

b. Ensure that the highlighter is at step 2 of the RNA Cell method, 
then press F1 (Start).

CAUTION!

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
120

Position
Waste√ 1

120
120

20%

20%
2
3 Waste

Waste 20%
�
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2 Perform the second wash.

a. Pipette 400 µL of RNA purification wash solution 2 over each 
sample in the purification tray.

CHEMICAL HAZARD. RNA purification wash 
solution 2 is a flammable liquid and vapor. Please read the MSDS, 
and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

b. Ensure that the highlighter is at step 3 of the RNA Cell method, 
then press F1 (Start).

3 Perform the third wash.

a. Pipette 300 µL of RNA purification wash solution 2 over each 
sample in the purification tray.

CHEMICAL HAZARD. RNA purification wash 
solution 2 is a flammable liquid nad vapor. Please read the MSDS, 
and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

b. Ensure that the highlighter is at step 4 of the RNA Cell method, 
then press F1 (Start).

To run the rest of the RNA Cell method: (continued)

Step Action

CAUTION!

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
120

Position
Waste√ 1

120
120

20%

20%
√ 2
3 Waste

Waste 20%
�

CAUTION!

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
120

Position
Waste√ 2

120
120

20%

20%
√ 3
4 Waste

Waste 20%
�
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4 Perform the fourth wash.

a. Pipette 300 µL of RNA purification wash solution 2 over each 
sample in the purification tray.

CHEMICAL HAZARD. RNA purification wash 
solution 2 is a flammable liquid and vapor. Please read the MSDS, 
and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

b. Ensure that the highlighter is at step 5 of the RNA Cell method, 
then press F1 (Start).

5 Ensure that the highlighter is at step 6 of the RNA Cell method, 
then press F1 (Start).

6 Ensure that the highlighter is at step 7 of the RNA Cell method, 
then perform touchoff.

To run the rest of the RNA Cell method: (continued)

Step Action

CAUTION!

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
120

Position
Waste√ 3

120
120

20%

20%
√ 4
5 Waste

Waste 20%
�

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
120

Position
Waste√ 4

300
120

20%

90%
√ 5
6 Waste

Waste 20%
�

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
120

Position
Waste√ 5

-
300

20%

-
√ 6
7 Touchoff

Waste 90%
�
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7 Move the carriage to the collection position and push the handle 
down until the carriage locks.

8 Perform an elution.

a. Pipette 150 µL of nucleic acid purification elution solution over 
each sample in the purification tray.

b. Move the highlighter to step 8 of the RNA Cell method, then 
press F1 (Start).

9 Ensure that the highlighter is at step 9 of the RNA Cell method, 
then perform touchoff.

10 Clear the instrument.

a. Remove the purification tray, archive plate, and splash guard 
from the instrument.

b. Save the archive plate for the rest of the qualification procedure. 
If necessary, store it at –15 to –25 °C until needed.

11 Continue with one of the following:

� “Analysis Using a UV Spectrophotometer” on page 3-17

� “Analysis Using the 7700 SDS” on page 3-17

To run the rest of the RNA Cell method: (continued)

Step Action

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
300

Position
Waste√ 6

120
-

90%

20%
 7
8 Collection

Touchoff -
�

Run “RNA Cell”
Step Time(s)

F1 F3 F4 F5F2

Start DoneLog

Vacuum
-

Position
Touchoff 7

-
120

-

-
√ 8
9 Touchoff

Collection 20%
�
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Analysis Using a UV Spectrophotometer

Introduction You can use a spectrophotometer to estimate the purity of the nucleic 
acid from the run on the 6100 prepstation. You take UV absorbance 
readings at wavelengths of 260 nm and 280 nm. If the ratio of the two 
readings (260/280) is > 1.8, the nucleic acid is considered pure.

Note It is important that the absorbance be measured within the quantitative 
range of the spectrophotometer you are using. Excessive dilution of the RNA 
sample will seriously affect the A260/280 ratio measured by your 
spectrophotometer. Generally, the apparent A260/280 ratio of your sample will be 
decreased by over-dilution.

Procedure

Analysis Using the 7700 SDS

Overview Analysis on the 7700 SDS consists of the following procedures, which 
must be done in order:

To perform analysis using a spectrophotometer: 

Step Action

1 Pipette any HCLC sample (from the left side of the 96-well archive 
plate) from the run on the 6100 prepstation to a cuvette on a 
spectrophotometer.

2 Using the spectrophotometer, measure the absorbance at 260 nm 
and 280 nm.

3 Calculate the A260/280 ratio.

If the A260/280 ratio is > 1.8, the 6100 prepstation passes the 
qualification test.

Procedure See Page

Sample Preparation 3-18

Real-Time PCR Run 3-21

Amplification Plot Analysis 3-27

Threshold Cycle Analysis 3-33

Qualification Analysis 3-40
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Sample Preparation

Overview This section describes how to prepare samples from the 6100 
prepstation run for analysis on the 7700 SDS. Preparation includes the 
following procedures:

Diluting RNA

Procedure See Page

Diluting RNA 3-18

Loading the Assay Plate 3-19

To dilute RNA: 

Step Action

1 Assemble the materials you will need:

� 96-Well output plate (archive plate) from the run on the 6100 
prepstation

� Two 96-well plates

� Nucleic Acid Purification Elution Solution

2 Perform a 1:20 dilution in a new 96-well plate.

a. Pipette 190 µL of elution solution into each of the following wells:
A1–A12 and B1–B12.

b. Pipette 10 µL of purified RNA from each well of the output plate 
from the 6100 prepstation to each of the corresponding wells 
(A1 to A1, B1 to B1, etc.) to which you added elution solution 
(A1–A12 and B1–B12). Pipette up and down to mix thoroughly.

3 Perform another dilution in a second new 96-well plate. 

In this step you perform a 1:10 dilution of the samples prepared in 
step 2, giving an overall dilution factor of the 1:200.

a. Pipette 180 µL of elution solution into each of the following wells:
A1–A12 and B1–B12.

b. Pipette 20 µL of the 1:20 dilution from step 2 above from each 
well of the 96-well plate into each of the corresponding wells (A1 
to A1, B1 to B1, etc.) on this plate (A1–A12 and B1–B12). 
Pipette up and down to mix thoroughly.
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Loading the
Assay Plate

To load the assay plate: 

Step Action

1 Assemble the materials you will need:

� New 96-well plate

� Last 96-well plate from “Diluting RNA” on page 3-18

� 18S RT+ master mix from “Preparing 1.25X 18S RT+ 
Master Mix” on page 3-8

� 18S RT– master mix from “Preparing 1.25X 18S RT– 
Master Mix” on page 3-9

� Nucleic Acid Purification Elution Solution

� High Recovered RNA Standard (HRS) from the kit

� Low Recovered RNA Standard (LRS) from the kit

2 Load master mix.

a. Pipette 40 µL of 18S RT+ master mix into each of the following 
wells: A1–F10 (70 wells total).

b. Pipette 40 µL of 18S RT– master mix into each of the remaining 
wells: F11–H12 (26 wells total).

3 Load 10 µL of “sample” into each well, according to the plate map 
shown on the following page. Pipette up and down to mix 
thoroughly.

4 Cover the plate with an optical adhesive cover.

“Sample” Description

HRS High Recovered RNA Standard

LRS Low Recovered RNA Standard

A1–B12 From designated wells of 96-well plate of dilution

NTC Elution solution
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Assay Plate Map for 7700 SDS

1 2 3 4 5 6 7 8 9 10 11 12

A HRS HRS HRS HRS HRS HRS HRS HRS HRS HRS LRS LRS

B LRS LRS LRS LRS LRS LRS LRS LRS NTC NTC A1 A1

C A2 A2 A3 A3 A4 A4 A5 A5 A6 A6 A7 A7

D A8 A8 A9 A9 A10 A10 A11 A11 A12 A12 B1 B1

E B2 B2 B3 B3 B4 B4 B5 B5 B6 B6 B7 B7

F B8 B8 B9 B9 B10 B10 B11 B11 B12 B12 NTC NTC

G A1 A2 A3 A4 A5 A6 A7 A8 A9 A10 A11 A12

H B1 B2 B3 B4 B5 B6 B7 B8 B9 B10 B11 B12
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Real-Time PCR Run

Purpose In this section, you use the assay plate you prepared in “Loading the 
Assay Plate” on page 3-19 for a real-time run on the ABI PRISM 7700 
Sequence Detection System (7700 SDS).

IMPORTANT Verify the performance of the 7700 SDS with the TaqMan® 

RNase P Instrument Verification Plate (P/N 4310982) before analyzing the 6100 
prepstation output using the 7700 SDS.

A real-time run involves the following procedures:

Performing
Sample Type

Setup

Procedure See

Performing Sample Type Setup 3-21

Programming Thermal Cycler Conditions 3-24

Loading the Reaction Plate 3-25

To perform sample type setup:

Step Action

1 Launch SDS software on the computer connected to the 7700 SDS.

Close the untitled window that appears.

2 From the File menu, select New Plate...

A New Plate dialog box appears.

3 Complete the New Plate dialog box as shown below:

4 Click OK.

An untitled window appears in the setup view.
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5 From the Sample Type pop-up menu, select Sample Type Setup...

The Sample Type Setup dialog box appears.

6 Complete the Sample Type Setup dialog box.

a. Set the following sample types with the reporter dye VIC:

� NTC

� UNKN

� STND

b. Verify that ROX is shown as the Reference dye.

c. Verify that TAMRA is selected as the Quencher dye.

d. Click OK.

The dialog box closes and the untitled window becomes active.

To perform sample type setup: (continued)

Step Action

Select VIC as the 
Reporter for Sample 
Types

Select TAMRA as the 
Quencher

The Reference should 
be ROX
3-22 6100 PrepStation Qualification



7 Select VIC from the Dye Layer pop-up menu.

8 Label STND-Standard wells.

a. Select wells A1–A12 and B1–B8.

b. From the Sample Type pop-up menu, select STND-Standard.

9 Label NTC-No Template Control wells.

a. Select wells B9, B10, F11, and F12.

Note Hold down the Control key to select multiple wells.

b. From the Sample Type pop-up menu, select NTC-No Template 
Control.

10 Label UNKN-Unknown wells.

a. Select wells B11, B12, C1–C12, D1–D12, E1–E12, F1–F10, 
G1–G12, and H1–H12.

b. From the Sample Type pop-up menu, select UNKN-Unknown.

The samples are set up as shown in the figure below.

11 Save the changes to the run file.

To perform sample type setup: (continued)

Step Action
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Programming
Thermal Cycler

Conditions

12 Go to “Programming Thermal Cycler Conditions” on page 3-24.

To perform sample type setup: (continued)

Step Action

To program thermal cycler conditions:

Step Action

1 Program thermal cycling settings.

a. Click the Thermal Cycler Conditions button.

A Thermal Cycler Conditions dialog box appears.

b. Program the Thermal Cycler Conditions as shown below.

c. Set the Reaction Volume to 50 µL.
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Loading the
Reaction Plate

2 Program data collection settings.

a. Click the Show Data Collection button in the dialog box.

Document icons indicate when the instrument will collect data.

b. Set the document icons as shown in the figure below.

Note Click a line segment to add or remove document icons.

3 Click OK.

The dialog box closes, and the plate read window becomes active.

To program thermal cycler conditions: (continued)

Step Action

To load the reaction plate:

Step Action

1 Place an optical cover compression pad on top of the assay plate 
you prepared in “Loading the Assay Plate” on page 3-19.

2 Load the assay plate into the 7700 SDS sample block.

IMPORTANT Start the 7700 SDS run immediately to prevent 
degradation of the reaction components.
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3 Secure the heated cover over the output plate.

a. Pull the heated cover forward.

b. Turn the knob clockwise to lower and secure the heated cover 
over the output plate

When securing the heated cover in place, be 
careful not to overtighten the knob. Damage to the instrument could 
occur.

4 Start the 7700 SDS run.

a. Click the Show Analysis button.

The analysis view appears.

b. Make sure that the temperature of the heated cover (Cov Temp) 
is > 100 °C.

c. Click the Run button.

d. Wait for the instrument to beep and the shutters to click before 
leaving.

To load the reaction plate: (continued)

Step Action

CAUTION!
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Amplification Plot Analysis

Purpose In this section, you use Sequence Detection Systems (SDS) 
software v. 1.6 or later to analyze the amplification plot and export the 
data.

This involves the following procedures:

Setting Analysis
Options

Procedure See Page

Setting Analysis Options 3-27

Analyzing Threshold Cycles 3-29

Exporting Data 3-32

To set analysis options:

Step Action

1 Save the real-time run file.

2 Click the Show Analysis button.

The analysis view appears.

3 From the Analysis menu, select Options.

An Analysis Options dialog box appears.
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Baseline and
Threshold
Guidelines

In analyzing threshold cycles (see the next page), you set the baseline 
and threshold values for analysis. Follow the guidelines below to ensure 
accurate analysis of the data.

Setting the Baseline

� Set the baseline to start at a cycle when background fluorescence 
is detected by the 7700 SDS.

Baselines usually start between 2 and 3.

� Set the baseline to stop at a cycle before fluorescence signals from 
amplification are generated and detected.

Baselines usually stop between 6 and 8.

Setting the Threshold

� Set the threshold value to 0.05.

At this value, fluorescence signals generated from RT+ samples 
should be increasing logarithmically. Adjustment of the threshold 
value from 0.05 may be necessary for optimal results.

4 Set the Analysis Options dialog box as shown below.

5 Click OK.

To set analysis options: (continued)

Step Action
3-28 6100 PrepStation Qualification



Analyzing
Threshold Cycles

To analyze threshold cycles:

Step Action

1 Select all wells.

2 From the Analysis menu, select Analyze.

The software analyzes the data, and an Amplification Plot window 
appears.

3 Set the Threshold Cycle Calculation values.

a. Set the Threshold value to 0.05.

b. Set the Baseline to Start at 2–3.

c. Set the Baseline to Stop at 6–8.
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4 Click Update Calculations.

The software updates the Amplification Plot.

5 Verify that the baseline and threshold are set properly.

a. The cycles set for the baseline should show no amplification.

b. The threshold value should indicate logarithmic growth of ∆Rn 
values.

To analyze threshold cycles: (continued)

Step Action

The threshold 
value indicates a 
logarithmic 
increase in ∆Rn 
values for all 
samples

There is no 
amplification in 
baseline cycles
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6 From the Viewer pop-up menu, select Ct vs Well position.

The view of the amplification plot changes.

7 Save the file.

To analyze threshold cycles: (continued)

Step Action

RT+ samples RT– samples

HRS

LRS NTC NTC

HCLC
LCLC

HCLC
LCLC
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Exporting Data To export data:

Step Action

1 From the File menu, scroll to Export, and select Results.

A file dialog box appears.

2 Enter the file name for the exported data, select a location for the 
data file, and click Export.

The data are exported into a data file in the selected location.
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Threshold Cycle Analysis

Purpose In this section you manipulate the exported data using Microsoft® Excel 
to calculate CT averages and standard deviations for the different 
sample groups. See “Example Qualification Data and Calculations” on 
page 3-44 for an example of a qualification analysis.

Threshold cycle analysis involves the following procedures:

Preparing the
Data File

Procedure See Page

Preparing the Data File 3-33

Calculating Average CT Values and Standard Deviations 3-36

Eliminating Outliers From Analysis 3-39

Eliminating Dropouts From Analysis 3-39

To prepare the data file:

Step Action

1 Using Microsoft Excel, open the data.xls file you saved in “Exporting 
Data” on page 3-32.

A Text Import Wizard dialog box appears.
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2 Complete Step 1 of the Text Import Wizard dialog box.

a. Select Delimited as the Original data type.

b. Start at row 1.

c. Select the appropriate File Origin.

d. Click Next.

3 Complete Step 2 of the Text Import Wizard dialog box.

a. Check the Tab box.

b. Click Next.

To prepare the data file: (continued)

Step Action
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4 Complete Step 3 of the Text Import Wizard dialog box.

a. Select General as the Column data format.

b. Click Finish.

The data file opens as a spreadsheet.

5 Delete the following columns:

� Baseline StdDev

� deltaRn

� Quantity

� Replicate

� Qty Mean

� Qty StdDev

� IPC

� Sample Name

6 Insert five columns:

� Avg CT (2x)

� Avg CT (2x) sorted

� Avg CT

� STDEV

� Specs

To prepare the data file: (continued)

Step Action
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Calculating
Average CT Values

and Standard
Deviations

7 Add cell borders to distinguish between the sample types.

a. Select row 11.

b. Click the Borders button.

The software applies a border to the bottom of row 11.

c. Repeat steps 7a and 7b for the following rows.

To prepare the data file: (continued)

Step Action

21 59 85

23 71 91

34 73 97

47 79

To calculate average CT values:

Step Action

1 Calculate the average CT value for each set of duplicates (HCLC 
RT+ and LCLC RT+ samples) in the Avg CT (2x) column.

a. In cell E24, enter the formula =AVERAGE(D24:D25), and press 
Return.

The software calculates the average for samples 23 and 24, a 
set of duplicates.

b. Select cells E24 and E25, and from the Edit menu, select Copy.

c. Select cells E26 through E71, and from the Edit menu, select 
Paste.

The software calculates the average for the remaining sets of 
duplicates.

2 Paste the average CT values for HCLC RT+ samples into column F.

a. Hold down the Command key, and select the average CT values 
in column E for HCLC RT+ samples.

b. From the Edit menu, select Copy.

c. Place the cursor in cell F24.

d. From the Edit menu, select Paste.
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3 Paste the average CT values for LCLC RT+ samples into column F.

a. Hold down the Command key, and select the average CT values 
in column E for LCLC RT+ samples.

b. From the Edit menu, select Copy.

c. Place the cursor in cell F36.

d. From the Edit menu, select Paste.

4 Sort the CT values for the sets of duplicates for the HCLC RT+ and 
for the LCLC RT+ samples in the Avg CT (2x) sorted column.

a. Select samples F24:F35, and from the Data menu select Sort.

b. Select samples F36:F47, and from the Data menu select Sort.

5 Calculate the average CT value for each sample group in the Avg CT 
column.

To calculate average CT values: (continued)

Step Action

In cell… Enter the formula…
Sample 
Group

G2 =AVERAGE(D2:D11) HRS RT+

G12 =AVERAGE(D12:D21) LRS RT+

G22 =AVERAGE(D22:D23) NTC RT+

G24 =AVERAGE(D24:D35, D48:D59) HCLC RT+

G36 =AVERAGE(D36:D47, D60:D71) LCLC RT+

G72 =AVERAGE(D72:D73) NTC RT–

G74 =AVERAGE(D74:D79, D86:D91) HCLC RT–

G80 =AVERAGE(D80:D85, D92:D97) LCLC RT–
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6 Calculate the standard deviation for CT values for each sample 
group in the STDEV column (column I).

7 Eliminate samples following the guidelines in the following sections, 
“Eliminating Outliers From Analysis” and “Eliminating Dropouts 
From Analysis,” before proceeding with the specification 
calculations.

To calculate average CT values: (continued)

Step Action

In cell… Enter the formula…
Sample 
Group

H2 =STDEV(D2:D11) HRS RT+

H12 =STDEV(D12:D21) LRS RT+

H22 =STDEV(D22:D23) NTC RT+

H24 =STDEV(F24:F29) HCLC RT+ 
below avg

H25 =STDEV(F30:F35) HCLC RT+ 
above avg

H36 =STDEV(F36:F41) LCLC RT+ 
below avg

H37 =STDEV(F42:F47) LCLC RT+ 
above avg

H72 =STDEV(D72:D73) NTC RT–

H74 =STDEV(D74:D79, D86:D91) HCLC RT–

H80 =STDEV(D80:D85, D92:D97) LCLC RT–
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Eliminating
Outliers From

Analysis

An outlier exhibits a CT value that differs by greater than three standard 
deviations from the average CT value for the sample group.

Eliminate from analysis up to four outliers from each output plate:

� Eliminate an RT+ sample from analysis if the CT value of the RT+ 
sample differs by greater than three standard deviations from the 
average CT value for the sample group and the CT value of the 
sample’s replicate is within three standard deviations of the average 
CT value for the sample group.

Note If the CT values of a sample and its replicate both differ by greater than 
three standard deviations of the average CT value for the sample group, then 
the sample set meets the definition of a dropout (See the next section, 
“Eliminating Dropouts From Analysis.”).

� Eliminate an RT– sample from analysis if the CT value of the RT–  
sample differs by greater than three standard deviations from the 
average CT value for the sample group.

� Eliminate a standard from analysis if the CT value of the standard 
differs by greater than three standard deviations from the average 
CT value for the sample group

Eliminating
Dropouts From

Analysis

A dropout consists of a set of duplicate samples that both exhibit CT 
values that differ by greater than three standard deviations from the 
average CT value for the sample group.

Eliminate up to two dropouts from each output plate from analysis.
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Qualification Analysis

Purpose In this section you use the CT values to measure the quality of the RNA 
prepared by the 6100 prepstation using three performance parameters.

Calculating
% RNA Recovery

For the RNA recovery to meet or exceed 50% of the RNA content of the 
lysate, the following equations must be true.

CT(HCLC RT+) – CT(HRS RT+) < 1.0

CT(LCLC RT+) – CT(LRS RT+) < 1.0

Performance Specification

% RNA Recovery The 6100 prepstation can recover ≥50% of 
the RNA content of the cell lysate control.

Precision of RNA Recovery The 6100 prepstation can recover RNA with 
a precision of <30% coefficient of variation 
(CV).

% DNA Contamination The 6100 prepstation can recover RNA 
containing <0.5% of DNA by weight.

To calculate % RNA recovery:

Step Action

1 Calculate ∆CT values for HCLC RT+ samples compared to standard 
HRS RT+ samples.

a. In cell I2, enter the formula =G24 – G2.

b. Verify that the difference is less than 1.0.

2 Calculate ∆CT values for LCLC RT+ samples compared to standard 
LRS RT+ samples.

a. In cell I12, enter the formula =G36 – G12.

b. Verify that the difference is less than 1.0.
3-40 6100 PrepStation Qualification



Calculating
Precision of RNA

Recovery

For the precision of RNA recovery to be less than 30% CV, the following 
equations must be true for the HCLC RT+ population and for the LCLC 
RT+ population.

For the standard deviation of CT values below the average CT:

[10(Std. Dev. CT/3.33) – 1] x 100 < 30%

For the standard deviation of CT values above the average CT:

[10(–Std. Dev. CT/3.33) – 1] x 100 < 30%

To calculate precision of RNA recovery:

Step Action

1 Calculate the % CV for the standard deviation of HCLC RT+ CT 
values below the average.

a. In cell I24, enter the formula

b. Press Return to calculate.

The % CV should be less than 30% for the installation to pass 
performance verification.

2 Calculate the % CV for the standard deviation of HCLC RT+ CT 
values above the average.

a. In cell K25, enter the formula

b. Press Return to calculate.

The % CV should be less than 30% for the installation to pass 
performance verification.

=(POWER(10, A/ 3.33)–1)*100

Where A is the value from cell H24, the standard 
deviation for HCLC RT+ CT values below the average

=(POWER(10, – B/ 3.33)–1)*100

Where B is the value from cell H25, the standard 
deviation for HCLC RT+ CT values above the 
average
6100 PrepStation Qualification 3-41



Calculating
% DNA

Contamination

For DNA contamination in the RNA samples to be less than 0.5% by 
weight, the following equation must be true:

CT(HCLC RT–) – CT(HCLC RT+) ≥ 16

3 Calculate the % CV for the standard deviation of LCLC RT+ CT 
values below the average.

a. In cell I36, enter the formula

b. Press Return to calculate.

The % CV should be less than 30% for the installation to pass 
performance verification.

4 Calculate the % CV for the standard deviation of LCLC RT+ CT 
values above the average.

a. In cell K37 for LCLC RT+ samples, enter the formula

b. Press Return to calculate.

The % CV should be less than 30% for the installation to pass 
performance verification.

To calculate precision of RNA recovery: (continued)

Step Action

=(POWER(10, C/ 3.33)–1)*100

Where C is the value from cell H36, the standard 
deviation for LCLC RT+ CT values below the average

=(POWER(10, – D/ 3.33)–1)*100

Where D is the value from cell H37, the standard 
deviation for LCLC RT+ CT values above the average

To calculate % DNA contamination:

Step Action

1 In cell I74, enter the formula =G74–G24.

2 Press Return to calculate.

3 Verify that the value is greater than or equal to 16.
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6100 Qualification
Requirement

Qualification of the 6100 prepstation using the Cell Lysate Control kit 
requires that the purified RNA meets Applied Biosystems specifications 
for % RNA recovery, precision of RNA recovery, and % DNA 
contamination.

If one or more of the specifications is not met, contact technical support 
(see “Technical Support” on page A-1) for assistance with using the kit 
or analyzing the data.
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Example Qualification Data and Calculations

Purpose This appendix contains data and calculations from an example 6100 
prepstation qualification run.

Example % RNA
Recovery

The figure below shows example data and calculations for determining 
% RNA recovery.

Example Precision
of RNA Recovery

The next figure shows example data and calculations for determining 
precision of RNA recovery.

∆CT values 
for HCLC 
RT+ 
samples 
compared to 
HRS RT+ 
samples is 
less than 1.0

∆CT values 
for LCLC 
RT+ 
samples 
compared to 
LRS RT+ 
samples is 
less than 1.0
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Example % DNA
Contamination

The figure below shows example data and calculations for determining 
% DNA contamination.

Table of Formulas The table below describes the formula or contents for each cell.

Cell Formula/Contents

E24 =AVERAGE(D24:D25)

E26:E71 pasted from E24:E25

F24:F35 pasted from E24:E34, E48:E58 and 
sorted in ascending order

F36:F47 pasted from E36:E46, E60:E70 and 
sorted in ascending order

G2 =AVERAGE(D2:D11)

G12 =AVERAGE(D12:D21)

G22 =AVERAGE(D22:D23)
3-46 6100 PrepStation Qualification



G24 =AVERAGE(D24:D35, D48:D59)

G36 =AVERAGE(D36:D47, D60:D71)

G72 =AVERAGE(D72:D73)

G74 =AVERAGE(D74:D79, D86:D91)

G80 =AVERAGE(D80:D85, D92:D97)

H2 =STDEV(D2:D11)

H12 =STDEV(D12:D21)

H22 =STDEV(D22:D23)

H24 =STDEV(F24:F29)

H25 =STDEV(F30:F35)

H36 =STDEV(F36:F41)

H37 =STDEV(F42:F47)

H72 =STDEV(D72:D73)

H74 =STDEV(D74:D79, D86:D91)

H80 =STDEV(D80:D85, D92:D97)

I2 =G24–G2

I12 =G36–G12

I24 =(POWER(10,A/3.33)–1)*100

Note A is the value from cell H24.

I25 =(POWER(10,–B/3.33)–1)*100

Note B is the value from cell H25.

I36 =(POWER(10,C/3.33)–1)*100

Note C is the value from cell H36.

I37 =(POWER(10,–D/3.33)–1)*100

Note D is the value from cell H37.

I74 =G74–G24

Cell Formula/Contents
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A
Technical Support A

Contacting

Technical Support
You can contact Applied Biosystems for technical support:

� By e-mail

� By telephone or fax

� Through the Applied Biosystems web site

You can order Applied Biosystems user documents, MSDSs, 
certificates of analysis, and other related documents 24 hours a day. In 
addition, you can download documents in PDF format from the Applied 
Biosystems web site. (Please see the section “To Obtain Technical 
Documents” following the telephone information below.)

To Contact
Technical Support

by E-Mail

You can contact Applied Biosystems Technical Support by e-mail for 
help in the following product areas:

Product/Product Area E-mail address

Genetic Analysis (DNA Sequencing) galab@appliedbiosystems.com

Sequence Detection Systems 
(Real-Time PCR) and PCR

pcrlab@appliedbiosystems.com

Protein Sequencing, Peptide, and DNA 
Synthesis

corelab@appliedbiosystems.com
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To Contact
Technical Support

by Telephone or
Fax (North

America)

To contact Applied Biosystems Technical Support in North America, use 
the telephone or fax numbers in the table below.

Note To schedule a service call for other support needs, or in case of an 
emergency, dial 1.800.831.6844, then press 1.

� Biochromatography (BioCAD®, 
SPRINT™, VISION™, and 
INTEGRAL® Workstations and 
POROS® Perfusion Chromatography 
Products)

� Expedite™ 8900 Nucleic Acid 
Synthesis Systems

� MassGenotyping Solution 1™ 

(MGS1) Systems

� PNA Custom and Synthesis

� Pioneer™ Peptide Synthesizers

� Proteomics Solution 1™ (PS1) 
Systems

� ICAT™ Reagent

� FMAT� 8100 HTS Systems

� Mariner� ESI-TOF Mass 
Spectrometry Workstations

� Voyager� MALDI-TOF 
Biospectrometry Workstations

� CytoFluor® 4000 Fluorescence Plate 
Reader

tsupport@appliedbiosystems.com

LC/MS 
(Applied Biosystems/MDS Sciex)

support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com

Product/Product Area E-mail address

Product/Product Area Telephone Fax

ABI PRISM® 3700 DNA Analyzer 1.800.831.6844, 
then press 8a

1.650.638.5981

DNA Synthesis 1.800.831.6844, 
press 2, then 
press 1a

1.650.638.5981
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Fluorescent DNA Sequencing 1.800.831.6844, 
press 2, then 
press 2a

1.650.638.5981

Fluorescent Fragment Analysis 
(including GeneScan® 
applications)

1.800.831.6844, 
press 2, then 
press 3a

1.650.638.5981

Integrated Thermal Cyclers 
(ABI PRISM® 877 and Catalyst 
800 instruments)

1.800.831.6844, 
press 2, then 
press 4a

1.650.638.5981

ABI PRISM® 3100 Genetic 
Analyzer

1.800.831.6844, 
press 2, then 
press 6a

1.650.638.5981

Peptide Synthesis 
(433 and 43x Systems)

1.800.831.6844, 
press 3, then 
press 1a

1.650.638.5981

Protein Sequencing 
(Procise® Protein Sequencing 
Systems)

1.800.831.6844, 
press 3, then 
press 2a

1.650.638.5981

Sequence Detection Systems 
(Real-Time PCR) and PCR

1.800.762.4001, 
then press:

1 for PCRa

2 for TaqMan® 
applications and 
Sequence 
Detection 
Systems including 
ABI Prism‚ 7700, 
7900, and 5700a

6 for the 6700 
Automated 
Sample Prep 
Systema

or

1.800.831.6844, 
then press 5a

1.240.453.4613

Product/Product Area Telephone Fax
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a. 5:30 AM to 5:00 PM Pacific time.

b. 8:00 AM to 6:00 PM Eastern time.

c. 9:00 AM to 5:00 PM Eastern time.

� Mariner� ESI-TOF Mass 
Spectrometry Workstations

� Voyager� MALDI-TOF 
Biospectrometry Workstations

� MassGenotyping Solution 1� 
(MGS1) Systems

� Proteomics Solution 1� (PS1) 
Systems

� ICAT� Reagent

1.800.899.5858, 
press 1, then 
press 3b

1.508.383.7855

Biochromatography 
(BioCAD®, SPRINT�, VISION�, 
and INTEGRAL®  Workstations 
and POROS® Perfusion 
Chromatography Products)

1.800.899.5858, 
press 1, then 
press 4b

1.508.383.7855

Expedite� 8900 Nucleic Acid 
Synthesis Systems

1.800.899.5858, 
press 1, then 
press 5b

1.508.383.7855

Pioneer� Peptide Synthesizers 1.800.899.5858, 
press 1, then 
press 5b

1.508.383.7855

PNA Custom and Synthesis 1.800.899.5858, 
press 1, then 
press 5b

1.508.383.7855

� FMAT� 8100 HTS Systems

� CytoFluor® 4000 
Fluorescence Plate Reader

1.800.899.5858, 
press 1, then 
press 6b

1.508.383.7855

Chemiluminescence (Tropix) 1.800.542.2369 
(U.S. only),
or 
1.781.271.0045c

1.781.275.8581

LC/MS 
(Applied Biosystems/MDS Sciex)

1.800.952.4716 1.508.383.7899

Product/Product Area Telephone Fax
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To Contact
Technical Support

by Telephone or
Fax (Outside

North America)

To contact Applied Biosystems Technical Support or Field Service 
outside North America, use the telephone or fax numbers below.

Region Telephone Fax

Eastern Asia, China, Oceania

Australia (Scoresby, Victoria) 61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 or
86 800 8100497

86 10 64106617

Hong Kong 852 2756 6928 852 2756 6968

India (New Delhi) 91 11 653 
3743/3744

91 11 653 3138

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 79588268 60 3 79549043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 2358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 
11

Belgium 32 (0)2 532 4484 32 (0)2 582 1886

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01

Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0)6150 101 0 49 (0)6150 101 101

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Portugal (Lisboa) 351.(0)22.605.33.14 351.(0)22.605.33.15

Spain (Tres Cantos) 34.(0)91.806.1210 34.(0)91.806.12.06

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

The Netherlands (Nieuwerkerk 
a/d IJssel)

31 (0)180 392400 31 (0)180 392409 
or
31 (0)180 392499

United Kingdom (Warrington, 
Cheshire)

44 (0)1925 825650 44 (0)1925 282502
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European Managed Territories (EMT)

Africa, English speaking
(Johannesburg, South Africa)

27 11 478 0411 27 11 478 0349

Africa, French speaking
(Paris, France)

33 1 69 59 85 11 33 1 69 59 85 00

India (New Delhi) 91 11 653 3743

91 11 653 3744

91 11 653 3138

Poland, Lithuania, Latvia, and 
Estonia (Warszawa)

48 22 866 40 10 48 22 866 40 20

For all other EMT countries not 
listed (Central and southeast 
Europe, CIS, Middle East, and 
West Asia)

44 1925 282481 44 1925 282509

Japan

Japan (Hacchobori, Chuo-Ku, 
Tokyo)

81 3 5566 6230 81 3 5566 6507

Latin America

Caribbean countries, Mexico, 
and Central America

52 55 35 3610 52 55 66 2308

Brazil 0 800 704 9004 or 
55 11 5070 9654

55 11 5070 9694/95

Argentina 800 666 0096 55 11 5070 9694/95

Chile 1230 020 9102 55 11 5070 9694/95

Uruguay 0004 055 654 55 11 5070 9694/95

Region Telephone Fax
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To Reach
Technical Support

Through the
Applied

Biosystems Web
Site

At the Applied Biosystems web site, you can search through frequently 
asked questions (FAQs) or a solution database, or you can submit a 
question directly to Technical Support.

Search FAQs

Search the Solution Database

Submit a Question

To search for FAQs:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Frequently Asked Questions.

3 Click you geographic region for the product area of interest.

4 Follow the instructions under the Frequently Asked Questions section 
(1) to display a list of FAQs for your area of interest.

To search for solutions to problems using the Solution Database:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Frequently Asked Questions.

3 Follow the instructions under the Search the Solution Database 
section (2) to find a solution to your problem.

To submit a question directly to Technical Support:

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Frequently Asked Questions.

3 In the Personal Assistance – E-Mail Support section (3), click Ask Us 
RIGHT NOW.

4 In the displayed form, enter the requested information and your 
question, then click Ask Us RIGHT NOW.

Within 24 to 48 hours, you will receive an e-mail reply to your 
question from an Applied Biosystems technical expert.
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To Obtain
Technical

Documents

You can obtain technical documents, such as Applied Biosystems user 
documents, MSDSs, certificates of analysis, and other related 
documents for free, 24 hours a day. You can obtain documents:

� By telephone

� Through the Applied Biosystems web site

Ordering Documents by Telephone

Obtaining Documents Through the Web Site

To order documents by telephone:

1 From the U.S. or Canada, dial 1.800.487.6809, or from outside the 
U.S. and Canada, dial 1.858.712.0317.

2 Follow the voice instructions to order documents (for delivery by fax).

Note There is a limit of five documents per fax request.

To view, download, or order documents through the Applied Biosystems 
web site:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Documents on Demand.

3 In the search form, enter and select search criteria, then click Search 
at the bottom of the page.

4 In the results screen, do any of the following:

� Click the pdf icon to view a PDF version of the document.

� Right-click the pdf icon, then select Save Target As to download a 
copy of the PDF file.

� Select the Fax check box, then click Deliver Selected Documents 
Now to have the document faxed to you.

� Select the Email check box, then click Deliver Selected Documents 
Now to have the document (PDF format) e-mailed to you.

Note There is a limit of five documents per fax request, but no limit 
on the number of documents per e-mail request.
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To Obtain
Customer Training

Information

To obtain Applied Biosystems training information:

Step Action

1 Go to http://www.appliedbiosystems.com

2 Click SERVICES & SUPPORT at the top of the page, then click 
Training.
Technical Support A-9







Headquarters
850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free: +1 800.345.5224
Fax: +1 650.638.5884

Worldwide Sales Offices
Applied Biosystems vast distribution and 

service network, composed of highly trained 
support and applications personnel, reaches 
into 150 countries on six continents. For 
international office locations, please call our 
local office or refer to our web site at 
www.appliedbiosystems.com or the Technical 

Support appendix in this document.  

www.appliedbiosystems.com

Applera Corporation is committed to providing the 
world’s leading technology and information for life 
scientists. Applera Corporation consists of the 
Applied Biosystems and Celera Genomics 
businesses.

Printed in the USA, 07/2001
Part Number 4316607  Rev. C 

an Applera business
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